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System and Hardware
Considerations
There are a variety of considerations to be aware of. These are documented in the following
pages:
l

"System requirements" on page 23

l

"Database Considerations" on page 12

l

"Environment considerations" on page 17

l

"Known Issues" on page 107

l

"Language and Encoding Considerations" on page 19

l

"Antivirus Exclusions " on the facing page

l

"Performance considerations" on page 20
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Antivirus Exclusions
Article #:
INFO-0002

Product:
OL Connect

Version:
1.5 and up

Description
The information on this page is designed to assist IT managers and IT professionals decide
what anti-virus strategy to follow with consideration to OL Connect and their internal
requirements and needs. This page describes the mode of operation and the files and folders
used by OL Connect as well as the files, folders and executables that are recommended to be
ignored for best possible performance and to avoid issues caused by antivirus file locks.
IT managers and IT professionals then may decide the anti-virus strategy to follow for their
internal requirements and needs depending on the statements outlined herein.

Directories and folders
Main installation folder
All Connect applications are installed under an arbitrarily selectable main folder. We will speak
of the "Installation Target" in the following. This installation target will hold the executables and
required files and folders for the operation of the whole product suite. All these files and folders
are static after their installation. It depends on the company virus protection strategy, if such
files and folders will be monitored or not. A virus protection on these files and folders should,
however, not have a big – if even any – impact on the performance of the Connect suite.
With some exceptions, which are listed below.
Connect Service
The Connect Service is run via the executable file ServerService.exe. This file has been
reported as causing issues with some antivirus packages, so we recommend adding this file to
the antivirus exclusion list, if possible.
The executable will be installed to the installation target "Connect Server" sub-folder. If the
default folder was selected during the installation process the file is likely to be as follows:
C:\Program Files\Objectif Lune\OL Connect\Connect Server\ServerService.exe

Page 10

Working folders
Working folders for Connect are created and used on a per-user-basis under the respective
user's profile folder, accessible on Windows with the standardized system variable
%USERPROFILE% in the subfolder "Connect". Working folders are:
l

l

l

l

%USERPROFILE%\Connect\filestore: This folder will hold non-intermediate files for the
operation of Connect. Files in this folder will be used frequently, but not with a high
frequency. Supervising this folder with a virus protection system should not have too
much of an impact on the speed of the whole Connect suite.
%USERPROFILE%\Connect\logs: As the name implies, log files are created and
updated here. These log files are plain text files. Virus protection may have an impact on
the speed of the whole Connect suite.
%USERPROFILE%\Connect\temp: Storage folder for temporary data, usually
intermittent files in multiple folders. Virus protection on this folder and its subfolders may
have a serious impact on the performance of Connect.
%USERPROFILE%\Connect\workspace: Usually containing settings and helper files
and folders. Supervising this folder with a virus protection system should not have too
much of an impact on the speed of the whole Connect suite.

Database 1
Depending on the components installed, a database instance is created in a folder called
"connect.database" under the Windows system temp folder.. This folder is accessible via the
standardized system variable %TMP%. Usually, folders holding such temporary files and
folders should be excluded from a virus protection, because this influences the overall
performance of the whole system at all. However the responsible person for the computer
protection has to decide about the monitoring of such temporary folders following the company
guidelines.
Database 2
Another database instance for Connect will be hold and used under the folder, which is
intended to hold data, accessible by and for all users. The path to this folder is stored in the
standardized system variable %PROGRAMDATA%. The Connect database instance is located
in the subfolder "Connect\MySQL".
As this database will be in extremely strong usage, virus protection on this folder and its subfolders may have a serious impact on the performance of Connect.
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Database Considerations
This page describes the different considerations and pre-requisites for the database back-end
used by PlanetPress Connect, whether using the MySQL instance provided by the installer, or
pre-existing (external) instance.

Using the MySQL Instance from the Installer
The MySQL Instance provided in the Installation Wizard is already pre-configured with options
to provide the most stable back-end setup.
These are the specific options that have been changed in our version of "my.ini":
l

l

l

max_connections = 200 : PlanetPress Connect uses a lot of database connections. This
number ensures that even in high volume environments, enough connections will be
available.
max_allowed_packet = 500M : In some implementations, especially when using Capture
OnTheGo, large packet sizes are required to allow transferring binary files. This
substantial packet size maximum setting ensures that the data received by PlanetPress
Connect will be able to be stored within the database.
character-set-server = utf8 , collation-server = utf8_unicode_ci , default-characterset=utf8 : These indicate database support for UTF-8/Unicode.

Installing / Updating Connect using an existing MySQL
instance
If MySQL Server is already present and you wish to use it, the following should be taken into
consideration:
l
l

l

l

The minimum supported MySQL version is 5.1.31.
The MySQL account must have access to all permissions using the GRANT Command,
including creating databases.
The database configuration must include the options detailed in the "Using the MySQL
Instance from the Installer" above topic above.
The database configuration must allow the use of mixed case table names.
This is particularly an issue on Linux MySQL installations.
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l

The SQL instance must be open to access from other computers. This means the bindaddress option should not be set to 127.0.0.1 or localhost.

Warning
If you chose not to install the supplied MySQL database, and instead opt for using a preexisting (External) database then you yourself must ensure that the External database is
accessible to Connect.
Objectif Lune Inc. will take no responsibility for database connections to any but the
supplied MySQL database.

Options available within the installer:

l
l

l

The Configuration page for the local MySQL is displayed.
MySQL settings are pre-filled with default values if no existing MySQL database
configuration is found.
MySQL settings are pre-filled with existing database configuration settings, if they point to
a MySQL database type.

Installing Connect using an existing Microsoft SQL Server
instance
If Microsoft SQL Server is already present and you wish to use it, the following should be taken
into consideration:

Warning
If you chose not to install the supplied MySQL database, and instead opt for using a preexisting (External) database then you yourself must ensure that the External database is
accessible to Connect.
Objectif Lune Inc. will take no responsibility for database connections to any but the
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supplied MySQL database.

Note
Since PlanetPress Connect version 1.6 the minimum required version of the MS SQL
Server is SQL Server 2012.

l

l

l

When MS SQL is selected, the default values for root user are sa and 1433 for the port.
If database settings from a previous OL Connect installation are found, the pre-exising
settings will be displayed for the matching database type. For MS SQL settings, this will
only work if they were created with Server Config Tool 1.5.0 or later, or the Installer for
OL Connect 1.6.0 or later.
If the database type is changed in the Installer configuration page, the default values for
this database type will be displayed.
If the pre-existing database settings are set to Hsqldb, the default database type selection
will be MySQL.
Selected database settings are stored in the preferences, and can be found in this file:
C:\ProgramData\Objectif Lune\OL
Connect\.settings\ConnectHostScope\com.objectiflune.repository.eclipselink.generic.pref
s

Updating With No Local MySQL Product
l

l

When updating a Connect installation from 1.5.0 which contains a Server Product but no
local MySQL Product, the Database Configuration Page will detect which database type
was set before (especially if the database configuration was switched from MySQL to MS
SQL using the Server Configuration Tool), and default to those settings.
On Update from 1.4.2 or earlier, the Database Configuration Page will always default to
MySQL connection settings, and if the installation was manually tweaked to connect to
MS SQL Server, the user has to switch to "Microsoft SQL Server" type and enter
connection details again.
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When modifying Connect
l

l

If local MySQL is removed from an installation, the Database Configuration page will offer
additionally the Microsoft SQL Server database type with respective default values.
If local MySQL is added to an installation, the usual MySQL Configuration page with
default values will be displayed.

If the user has installed the Installer Supplied MySQL and then switches to an external
Microsoft SQL by using the Server Configuration Tool, the supplied MySQL cannot be switched
off. By design the installer adds a service dependency between Connect Server and the
supplied MySQL service.

Note
The Microsoft SQL selection capability will be available only with 1.6 version and
upwards.

To remove this dependency the user needs to do the following
1. Have a foreign Microsoft SQL running, ready for use with Connect Server.
2. Use the Server Configuration Tool "Database Connection preferences" on page 85 to
switch the database to Microsoft SQL.
3. Re-start the Connect Server Service, so that the modifications become active.
4. Counter check that everything is working properly with Microsoft SQL.
5. Open a command-line prompt with full administration rights.
6. Enter the command sc config OLConnect_Server depend= /. This removes the
dependency.
Please be aware: The key word depend must be followed immediately by the equal sign,
but between the equal sign and the forward slash there must be a space.
Additional information can be found here: http://serverfault.com/questions/24821/howto-add-dependency-on-a-windows-service-after-the-service-is-installed#228326.
7. After the dependency has been removed, it is possible to stop the supplied MySQL
service (OLConnect_MySQL).
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Warning
If a Connect 1.5 user wants to use Microsoft SQL instead of MySQL for the Connect Server,
there are several points to be taken care of. These are:
l

l

If a MySQL instance exists which could be used intermediately, then this should be
selected during the setup. This ensures, that nothing gets installed. Otherwise the
supplied MySQL needs to be installed and the switch to Microsoft SQL needs to be
done as outlined above.
It is not possible to uninstall the supplied MySQL hereafter, when running the
Connect 1.5 Installer in Modify mode.

Important
If a Server Product and a MySQL Product were selected to be installed on Connect 1.5.0, and
then the Server Configuration Tool is used to switch the database used by the Server to an
external Microsoft SQL, then the Update to 1.6 requires an extra step. The procedure is as
follows:
1. Run the Update to Connect 1.6. This will assume the local MySQL database needs to
be updated and configured, so the user has to enter a root password on the MySQL
Configuration Page (can be any password matching Connect security rules).
2. After the update, the Connect 1.6 Setup needs to be run once more to modify Connect.
3. On the Product Selection page, now the MySQL product can be unselected.
4. When stepping forward in the Wizard, the Database Configuration page will be displayed
which allows to configure the Microsoft SQL Server with appropriate settings.
After this modification, the local MySQL is removed, and also the service dependency from
Server to MySQL is removed.

Note
If Connect was initially installed not containing the local MySQL product (i.e. on 1.5
installation an external MySQL was configured as database), then the Update to 1.6 will
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allow to select either external MySQL or external Microsoft SQL on the Database
Configuration Page.

Environment considerations
Terminal Server/Service Support
PlanetPress Connect does not support Terminal Server (or Terminal Service) environment as
possible under Windows 2000, 2003 and 2008. This is to say, if Terminal Service is installed
on the server where PlanetPress Connect is located, unexpected behaviours may occur and
will not be supported by Objectif Lune Inc.. Furthermore, using PlanetPress Connect in a
Terminal Service environment is an infringement of our End-User License Agreement.

Virtual Machine Support
PlanetPress Connect supports the following virtual environments:
l

l

l

VMWare Environments. This includes VMWare Player, VMWare Workstation as well as
VMWare ESX Server.
VMWare VMotion. This means the virtual machine hosting PlanetPress Connect can be
automatically moved from one ESX server to another in a clustered installation.
Microsoft Hyper-V/Azure infrastructure environments.

PlanetPress Connect is not officially supported on any other virtual machines such as Virtual
PC, Parallels, Bochs, Xen, etc.

Warning
Copying (duplicating) a Virtual Machine with Connect installed and using both images
simultaneously constitutes an infringement of our End-User License Agreement.
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Note
While some virtual machine environments (from VMWare and Microsoft) are supported,
other virtual environments (such as Parallels, Xen and others) are not supported at this
time.

Remote Desktop Support
Tests have demonstrated that PlanetPress Connect can be used through Remote Desktop. It is
however possible that certain combination of OS could cause issues. If problems are
encountered, please contact OL Support and we will investigate.
PlanetPress Connect 1.3 and later have been certified under Remote Desktop.

32-bit or 64-bit Operating Systems?
PlanetPress Connect is a 64-bit software and can only be installed on 64-bit operating
systems.

Antivirus Considerations
l

l

Antivirus software may slow down processing or cause issues if they are scanning in
temporary folders or those used by PlanetPress Connect. Please see Antivirus Exclusion
for more information.
Antivirus software might interfere with installation scripts, notably a vbs script to install
fonts. McAfee, in particular, should be disabled temporarily during installation in order for
MICR fonts to install and the installation to complete successfully.

Windows Search Indexing Service
Tests have concluded that the Windows Search service, used to provide indexing for Windows
Search, can interfere with Connect when installing on a virtual machine. If the installation
hangs during the last steps, it is necessary to completely disable this service during installation.
l

Click on Start, Run.

l

Type in services.msc and click OK.
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l

Locate the Windows Search service and double-click on it.

l

Change the Startup Type to Disable, and click Stop to stop the service.

l

Try the installation again.

l

Once completely, you may re-enable the service and start it.

Commandline switches and .ini entries
PlanetPress Connect is intended to work stably and reliably, based on Java and the Eclipse
framework. To ensure this reliability and robustness, many Java and Eclipse parameters have
been tested and tuned, which is reflected in the respective .ini entries and the used command
line switches. A collection of valuable settings has been elaborated and found its entry in
PlanetPress Connect “good switches list” (called the “whitelist”).
The protection of the end user’s system is one of our main goals and therefore we have
implemented a very strict verification mechanism, which ensures, that only these whitelisted ini
entries and command-line switches are accepted, when one of Connect components is started
and run. Please be therefore advised, that any non-whitelisted ini entry or command-line switch
will be accepted and will - if tried to be used - lead to the respective application’s “sudden
death”. If you should encounter such a behaviour then please double-check your Connect log
file/s for respective entries.

Language and Encoding Considerations
Please note the following considerations:
l

Language:
l

PlanetPress Connect is currently offered in several languages. These languages
can be switch between via the Preferences dialog. The current languages include:
l

English

l

French

l

German

l

Spanish

l

Italian

l

Korean

l

Portuguese
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l

Chinese (Simplified)

l

Chinese (Traditional)

l

Japanese.

The default language is English.
The PlanetPress Connect help system (this document) is currently only available in
English.
l

Encoding:
l

Issues can sometimes be encountered in menus and templates when running
PlanetPress Connect on a non-English operating system. These are due to
encoding issues and will be addressed in a later release.

Network Considerations
The following should be taken into consideration in regards to network settings and
communications
l

If a local proxy is configured (in the Internet Explorer Options dialog), the option
Bypass proxy server for local addresses must be checked, or some features
depending on local communication will not work.

Firewall/Port considerations
For Firewall/Port considerations, please see this article in the Knowledge Base: Connect
Firewall/Port Configuration

Performance considerations
In order to get the most out of PlanetPress Connect, it is important to determine how best to
maximize performance. The following guidelines will be helpful in extracting the best
performance from PlanetPress Connect and they give a rough indication when it would be
useful to start looking into hardware upgrades or extra PlanetPress Connect Performance
Packs.
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Performance analysis details
Connect's output speed is limited to a certain number of output items (web pages, emails, or
printed pages) per minute. What the maximum total output speed will be is determined by your
licence and any additional Performance Packs you might have (see "Speed quota: PPM and
speed units" on page 123).
To get an indication of the actual Print output speed, output a Print template to a PDF, PS file,
using one single Weaver engine and the maximum number of speed units per job (see
"Weaver engine scheduling" on page 135).
Next, open the log file of the Weaver engine. By default, the log files are located in this folder:
C:\Users\[username]\Connect\logs\WeaverEngine, where [username] needs to be replaced
with your own Windows username. Search the log file for "PPM" (pages per minute). Repeat
this a few times to determine the average output speed.
Likewise, the output speed for an Email or Web template can be found by running it with one
Merge engine and maximum speed units; in the Merge engine's log file, search for "PPM".
If your jobs are not running at the licensed speed, there may be several ways to improve
performance, as described below. Make sure to address all issues mentioned in this topic
before deciding that you need to invest. Note however that it is not guaranteed that the licensed
speed can be achieved with any job. Creating output for templates with very complex scripts or
complex graphics resources will take a certain amount of time, even on high-end hardware.
Improving performance beyond what can possibly be reached by using the methods described
below requires purchasing either a Performance Pack or upgrading to PReS Connect (see
Performance Packs). For advice please contact your local sales office (see Objectif Lune's
Contact page).

Engine configuration
As explained in another topic (Connect: a peek under the hood) the Connect Server cooperates
with different engines to handle specific tasks.
A DataMapper engine extracts data from a data file. A Merge engine merges the template and
the data to create Email and Weboutput, or to create an intermediary file for Printed output. The
intermediary file is in turn used by a Weaver engine to prepare the Print output.
Configuring these engines to match both the hardware configuration and the typical usage
situation is probably the most effective way to improve Connect's performance.
Particularly launching a higher number of Merge engines can have a great, immediate impact
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on performance. When first installed, PlanetPress Connect is configured to use 2 Merge
engines. An engine will run mostly single-threaded. To benefit from modern multi-core systems
it is recommended to run more engines in parallel.
The number of engines is one of the "Scheduling Preferences" that let the Connect Server
manage its workload in such a way that the highest possible output speed is achieved.
For an explanation and guidelines, see "Engine configuration" on page 121. See "Scheduling
preferences" on page 131 for an overview of the dialogs.

Note
Connect Server and Designer each have their own distinct scheduling preferences. Use the
Connect Server Configuration tool to change Connect Server's settings.

Template optimization
When you find that the speed per Merge engine - the Content Creation speed - is low,
optimizing a template can make a huge difference. For advice on how to optimize a template
see: Optimizing a template.

Network and internet connections
Use a fast network and internet connection or avoid loading external or internet resources.
Using images, JavaScript or CSS resources located on a slow network or on a slow internet
connection will obviously lead to a loss of speed. While we do our best for caching, a document
with 5,000 records which queries a page that takes 1 second to return a different image each
time will, naturally, slow output generation down by up to 83 minutes.

Hardware configuration
When processing speed is important, the following is suggested before looking into
Performance Packs to enhance performance (and after addressing the other issues mentioned
in this topic).
l

Antivirus exclusions. Sometimes, virus scanners, other security software or indexing
services can interfere. It can help to disable those kinds of tools for the areas where
Connect stores intermediate files. You could exclude the entire
C:\Users\<connectuser>\Connect folder. See also: "Antivirus Exclusions " on
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page 10 .
l

l

l

l

l

Use a high-performance, low-latency hard drive. Connect benefits from fast I/O. This is
especially true for DataMapper engines (see "DataMapper engine" on page 125).
Preferably use a Solid State Drive (SSD) or similar for storage.
Use at least 8+ GB High-Quality RAM. Check memory usage while the Print command is
being executed to see if you need more than the minimum of 8GB. Assuming that the
Connect Server and the Connect database need 1GB each, and that each engine needs
1GB as well, you can roughly estimate how much memory is needed.
Consider using a physical machine instead of a virtual machine. When running on a
Virtual Machine, the machine may report that it has sufficient hardware (cores) available,
but in a virtual environment you need to make sure that this hardware is not being shared
with lots of other virtual machines.
Consider using hardware with more physical cores. PlanetPress Connect doesn't limit
the number of Merge engines that is used for a Print job, so if the number of physical
cores is low, it makes sense to see if that can be increased. When running on a virtual
machine, this is usually easy. When running on a physical machine, it means that you
may have to switch hardware.
For both virtual and non-virtual environments, make sure the machine is not busy with all
kinds of other processes.

System requirements
These are the system requirements for PlanetPress Connect 2019.1

Operating system (64-bit only)
l

Microsoft Windows 2008 R2 Server

l

Microsoft Windows 2012/2012 R2 Server

l

Microsoft Windows 2016 Server

l

Windows 7

l

Microsoft Windows 8.1

l

Microsoft Windows 10 (Pro and Enterprise versions only)
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Note
Windows Vista, Windows 8.0, Windows 2003 Server and earlier versions of Windows are
not supported by OL Connect products.

Virtual Environments
l

VMWare/VSphere

l

Hyper-V

l

Azure

l

Amazon Web Services (AWS)

Minimum hardware requirements
As with any software application, minimum hardware requirements represent the most basic
hardware on which the software will run. Note however that settling for the minimum
specification is unlikely to produce the performance you expect from the system. It can be used
when configuring a trial or a development system, however.
l

File system: NTFS (FAT32 is not supported)

l

CPU: multi-core

l

RAM: 6GB

l

Disk Space: 4GB for the software modules, 5GB for work files*1

*1: depends on the amount of data you process through OL Connect. For instance, a PostScript
file containing several thousands of documents could easily take up several GBs.

Recommended hardware requirements
Due to its versatility, OL Connect is used for a wide variety of applications. Consequently, it is
difficult to determine which hardware configuration will produce the best results for any given
implementation. The following specs should therefore be viewed as a general guideline that is
most likely to produce expected results for most implementations. You should, however, keep
in mind that it may not represent the optimal setup for your particular application.
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For more information and tips about performance considerations, see "Performance
considerations" on page 20.
l

File system: NTFS (FAT32 is not supported)

l

CPU: Intel Core i7-4770 Haswell or equivalent

l

RAM: 16GB

l

Disk Space: 4GB for the software modules, 20GB for work files*1

l

Storage Type: Solid State Drive (SSD)

l

Networking: 10Gb Ethernet

*1: depends on the amount of data you process through OL Connect. For instance, a PostScript
file containing several thousands of documents could easily take up several GBs.

Requirements for individual Connect modules
OL Connect Products comprises multiple modules that can be operated separately on multiple
PCs. Each module has its own set of requirements that may differ from the other modules.
While the hardware requirements described above are relatively generic when installing all
Connect modules on a single server, they should not be interpreted literally for each individual
module.
When installing on multiple PCs, keep the following rules of thumb in mind:
l

l

l

l

The Connect Workflow module requires less RAM but fast hard drive access. It also
benefits from fast multi-core CPUs, in order to run processes in parallel.
The Connect Server module requires more RAM and benefits from fast multi-core CPUs.
Disk access speed is less of a concern.
The Connect Designer module requires more RAM and fast disk access to provide a
responsive user-experience.
The back-end database (MySQL by default) benefits from more RAM, speedy disk access
and fast networking as it will be solicited by all modules simultaneously.

Editions of Connect Products
There are three editions of OL Connect: PrintShop Mail Connect, PlanetPress Connect and
PReS Connect.
While all three editions share common modules, they are generally not used for the same
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purposes. Technically speaking, their hardware requirements would therefore be the same but
in practice, PReS Connect is likely to require higher-end hardware while PrintShop Mail
Connect will generally require less power to achieve expected results.

Note
As with any JAVA application, the more RAM available, the faster PlanetPress Connect will
execute.
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Installation and Activation
This topic provides detailed information about the installation and activation of PlanetPress
Connect 2019.1.

Note
A PDF version of this guide is available for use in offline installations. Click here to
download it.

PlanetPress Connect 2019.1 is comprised of 2 different installers: one for the PlanetPress
Connect software and one for PlanetPress Workflow 2019.1.

Where to obtain the installers
The installers for PlanetPress Connect 2019.1 and PlanetPress Workflow 2019.1 can be
obtained on DVD or downloaded as follows:
l

l

If you are a Customer, the installers can be downloaded from the Objectif Lune Web
Activation Manager or through the OL Update Client if it is activated.
If you are a Reseller, the installers can be downloaded from the Objectif Lune Partner
Portal site or through the OL Update Client if it is activated.

Installation - important information
For important information about the Installation, including requirements and best practices,
please see the following topics:
l

Installation Prerequisites

l

User accounts and security

l

Migrating to a new computer

l

"Upgrading from previous Connect Versions" on page 60
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Installation - "How to" guides
For information on how to conduct the installation itself, chose from the following topics:
l

Installation

l

Silent Installation

l

Installation on machines without Internet access

Activation
For information on licensing, please see Activating your license.

Installation Prerequisites
l
l

l

l

l

l

Make sure your system meets the System requirements.
PlanetPress Connect Version 2019.1 can be installed under a regular user account with
Administrator privileges.
PlanetPress Connect must be installed on an NTFS file system.
PlanetPress Connect requires Microsoft .NET Framework 4.5 already be installed on
the target system.
Connect 2019.1 requires updated Connect License and/or Update Client.
See "Upgrading from previous Connect Versions" on page 60 for details.
In order to use the automation features in Version 2019.1, PlanetPress Workflow
2019.1 will need to be installed.
This can be installed on the same machine as an existing PlanetPress® Suite 7.x
installation or on a new computer.
For more information, please see "Information about PlanetPress Workflow" on page 59.
If Workflow installation finds that .NET 4.0 is not already installed, it will install that
version as part of the setup process.
If LaserFiche or the ICR libraries are chosen as part of the Workflow installation, then
.NET 3.5 must also be installed. This will need to be installed manually, as .NET 3.5 is
not included in the Workflow setup.
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User accounts and security
Connect generally requires only standard Windows user credentials to run, but does require a
user with local Windows Administrator when installing the software and when activating the
software license. This is to allow read/write access to protected Windows folders and registry
entries.
The following links contain the details as to when and where Windows Administrator rights are
required:
l

Connect Installation: Connect Installation

l

Activating Connect: Activating a License

Permissions for PlanetPress Connect Designer
PlanetPress Connect Designer does not require any special permissions to run besides that of
a regular program. It does not require administrative rights and only needs permission to
read/write in any folder where templates or data mapping configurations are located.
If generating Print output, PlanetPress Connect Designer requires permission on the printer or
printer queue to send files.
Permissions for PlanetPress Connect Server
The PlanetPress Connect Server module, used by the Automation module, requires some
special permissions to run. These permissions are set during installation, in the Engine
Configuration portion of the Installation Wizard, but it can also be configured later by modifying
permissions for the service. To do this:
l

l

l

l

In Windows, open the Control Panel, Administrative Tools, then Services (this may
depend on your operating system).
Locate the service called Serverengine_UUID , where UUID is a series of characters that
depend on the machine where the software is installed.
Right-click on the service and select Properties.
In the Connection tab, define the account name and password that the service should
use. This can be a local account on the computer or an account on a Windows Domain.
The account must have administrative access on the machine. It should also correspond
to the user account set up in PlanetPress Worfklow.
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Installing PlanetPress Connect on
Machines without Internet Access
Installing PlanetPress Connect2019.1 in offline mode requires some extra steps. These are
listed below.

Updating Connect
Updating to Connect 2019.1 from earlier Connect version
In order to update PlanetPress Connect to 2019.1 it is first necessary to update the Connect
License.
For details on how to upgrade the Connect License offline see the Upgrading Connect on
machines with no internet access section in the Update Client 1.2.40 Upgrade Guide.

Initial Connect Installation
GoDaddy Root Certificate Authority needs to be installed
In order to install PlanetPress Connect it is necessary for the GoDaddy Root Certificate
Authority to be installed (G2 Certificate) on the host machine and for this to be verified online.
When a machine hosting the installation does not have access to the Internet, the installation
will fail because the verification cannot be performed. To solve this problem one must first
ensure that all Windows updates have been installed on the host machine. Once the Windows
updates are confirmed as being up to date, then complete the following steps:
1. Go to https://certs.godaddy.com/repository and download the following two certificates to
copy to the offline machine:
l

l

GoDaddy Class 2 Certification Authority Root Certificate - G2 - the file is gdrootg2.crt
GoDaddy Secure Server Certificate (Intermediate Certificate) - G2 - the file is
gdig2.crt

2. Install the certificates: Right mouse click -> Install Certificate, and follow the steps through
the subsequent wizard.
3. Now copy the PlanetPress Connect installer to the offline machine and start the
installation as normal
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Windows certificate validation - Certificate Revocation List retrieval should be switched
off
For your security Objectif Lune digitally signs all relevant files with our own name and
certificate. The integrity of these files is checked at various times by different, context related,
methods. One of these checks, done during the installation process, uses the Windows
certificate validation check. .
The Windows certificate validation process not only checks the integrity of a file against its
signature, but also usually checks if the certificate itself is still valid. That check is done against
the current Certificate Revocation List (CRL), which needs to be retrieved from the internet.
However, if the machine in question does not have internet access, the retrieval of the CRL
must fail, which will lead to subsequent validation issues.
To circumvent such issues it is highly recommended to switch off the CRL retrieval prior to
installing Connect on machines without internet access. There is no security risk associated
with this, as the CRLs would never be retrievable without internet access, anyway. Advantage
of the switch will not only be found during the installation and operation of Connect, but also in
some speed improvements for any application which use signed binaries.
To switch off CRL retrieval on the computer, complete the following steps:
1. Open the “Internet Options” via the Control Panel
2. Select the “Advanced” tab and scroll down to “Security” node.
3. Uncheck the entry “Check for publisher’s certificate revocation” under that node.
4. Click the OK button to close the dialog.
5. Re-start the computer.

Installation Wizard
Updating to Connect 2019.1 from earlier Connect version
In order to update PlanetPress Connect to 2019.1 it is first necessary to update the Connect
License.
For details on how to upgrade the Connect License see "Users of Connect prior to 2019.1" on
page 60

Page 31

Starting the PlanetPress Connect installer
The PlanetPress Connect installer may be supplied as an ISO image or on a DVD.
l

If an ISO image, you can choose between the following, depending upon your Operating
System and the choices available:
1. Burn the ISO image onto a DVD
2. Un-zip the contents to a folder (keeping the internal folder structure intact)
3. Mount the ISO image from within Windows Explorer

l

If on a DVD, either insert the DVD and initiate the installation from there or copy the
contents to a folder on the target computer (keeping the folder structure intact)

Navigate to the PlanetPress_Connect_Setup_x64.exe and double-click on it. After a short
pause the Setup Wizard will appear as a guide through the installation steps.
Note that PlanetPress Connect requires prior installation of Microsoft .NET Framework 4.5. For
a full list of other prerequisites, see "Installation Prerequisites" on page 28.
Running the Installation with extra logging
The installer can be run with enhanced logging options, if needed.
To do so, run the PlanetPress_Connect_Setup_x64.exe from the command line with one of the
following command line options:
l

PlanetPress_Connect_Setup_x64.exe --verbose
This adds extra debugging style logging to the installation process.

l

PlanetPress_Connect_Setup_x64.exe --trace
This adds full trace style logging to the installation process. The log file this produces will
be very large, as this option logs everything.

Selecting the required components
After clicking the Next button, the component selection page appears, where the different
components of PlanetPress Connect can be selected for installation. Currently, the following
are available:
l

PlanetPress Connect Designer: The Designer module (see The Designer) can be
installed standalone (with no other installed modules) on as many machines as you like. It
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does not require a license to run as a standalone designer tool . This allows for any
number of people to use the Designer for creating jobs, but without production capabilities
such as automation and commingling.
l

l

PlanetPress Connect Server: The Server back-end that provides Connect production
capabilities such as production content creation (print output, HTML content for emails
and web pages), automation, commingling and picking.
MySQL:
A supplied MySQL database used by PlanetPress Connect.
The database is used for referencing temporary Connect files and for sorting temporarily
extracted data, and similar.
A pre-existing MySQL or Microsoft SQL server (referred to as an external database, in
this documentation) could be used instead, for the same purposes.
The external database could reside on the same computer or on a separate server.
If you wish to make use of an external database, please make sure the MySQL option is
not selected.

Warning
If you chose not to install the supplied MySQL database, and instead opt to use a
pre-existing external database, then you must ensure that your external database is
accessible to Connect, yourself.
Objectif Lune Inc. will take no responsibility for database connections to any but the
supplied MySQL database.
See "Database Considerations" on page 12 for more information about setting up
external databases.

l

Installation Path: This is the location where modules are to be installed.

Note
To cater for MySQL requirements, the installation path cannot contain any non
ASCII characters (such as Asian language Unicode characters). Nor can it contain
characters that Windows disallows in filenames (such as '?', ''>' or trailing spaces).
If an invalid character is entered, the Installation Path entry box will turn red and a
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description of the error will be displayed in the information area.

The installer can also calculate how much disk space is required for installing the selected
components as well as how much space is available:
l

l

l

l

Disk space required: Displays the amount of space required on the disk by the selected
components.
Disk space available on drive: Displays the amount of space available for installation on
the drive currently in the Installation Path.
Recalculate disk space: Click to re-check available disk space. This is useful if space
has been made available for the installation while the installer was open.
Source repository location: Displays the path where the installation files are located.
This can be a local drive, installation media, or a network path.

End User License Agreement
The next page displays the End User License Agreement, which needs to be read and
accepted before clicking Next.

Configuring Supplied Database Connection
The Default Database Configuration page appears if the supplied MySQL module was
selected for installation in the Product Selection screen. It defines the administrative password
for the MySQL server as well as which port it uses for communication.
The installer will automatically configure the Connect Server to use the supplied password and
port.
l

MySQL user 'root' Password: Enter the password for the 'root', or administration
account, for the MySQL server. The password must be at least 8 characters long and
contain at least one of each of the following:
l

a lower case character (a, b, c ... )

l

an upper case character (A, B, C ...)
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l

a numeric digit (1, 2, 3 ...)

l

a punctuation character (@, $, ~ ...)

For example: "This1s@K"

Note
When updating from an earlier Connect version, the appropriate MySQL password
must be entered or the update will fail.
If the password is subsequently forgotten, then MySQL must be uninstalled and its
database deleted from disk before attempting to reinstall.

l

l

Confirm MySQL user 'root' Password: Re-enter to confirm the password. Both
passwords must match for installation to continue.
TCP/IP Port Number: The port on which MySQL will expect, and respond to, requests. A
check is run to confirm whether the specified TCP\IP Port Number is available on the
local machine. If it is already being used by another service (generally, an existing
MySQL installation), the number is highlighted in red and a warning message is
displayed at the top of the dialog.

Note
The MySQL database controlled by the OLConnect_MySQL service communicates
through port 3306 by default.

l

Allow MySQL Server to accept non-local TCP connections checkbox: Click to enable
external access to the MySQL server.

Note
This option is required if MySQL Server will need to be accessed from any other
machine.
It will also be required if the MySQL database is on a separate machine to this
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PlanetPress Connect installation.

Tip
This option may represent a security risk if the machine is open to the internet.
We heavily recommended that your firewall is set to block access to port 3306 from
external requests.

Configuring External Database Connection
The Database Connection page appears if the supplied MySQL module was not selected for
installation. This page is for setting up the connection to the existing External database.
l

l

l

l

l

l

Database Configuration: Select the database type to use for thePlanetPress Connect
Engine. Currently only MySQL and Microsoft SQL Server are supported.
Administrator Username: Enter the user account of a user with database administrative
rights. Administrative rights are required since tables will need to be
created/modified/dropped in the database.
If accessing a database on a different machine, the server must also be able to accept
non-local TCP connections, and the user account must also be configured to accept
remote connection. For example, the "root" MySQL user entered as root@localhost is not
allowed to connect from any other machine than the one where MySQL is installed.
Database Instance Name: Enter an existing Microsoft SQL Server's instance name.
This option only applies to existing Microsoft SQL Server instances, and not for MySQL.
TCP/IP Port Number: Enter the port on which the database server expects connections.
For MySQL, this is 3306 by default.
For Microsoft SQL Server it is 1433 by default.
Server Schema/Table: Enter the name of the MySQL database into which the tables will
be created. The Connect standard name is "objectiflune".
Administrator Username: Enter the user account of a user with database administrative
rights. Administrative rights are required since tables will need to be
created/modified/dropped in the database.
If accessing a database on a different machine, the server must also be able to accept
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non-local TCP connections, and the user account must also be configured to accept
remote connection. For example, the "root" MySQL user entered as root@localhost is not
allowed to connect from any other machine than the one where MySQL is installed.
l

l

Administrator Password: Enter the password for the above user account. For
MySQL the appropriate password must be entered or the Connect installation will fail.
Use Encrypted SSL Connection checkbox: Check to enable encrypted connections to
MySQL (v5.6.43, v5.7.25, v8.0.x or later) databases using SSL.
The secure connection to MySQL is for the "objectiflune" schema.

Note
It is not in the scope of the Connect installer to configure the MySQL database
Server to accept SSL connections. This must be done prior to the installation of
Connect.
By default, the connection will not verify the server certificate
(verifyServerCertificate=false), which would allow connecting to a server using a
self-signed certificate. If such a certificate is required, then this setting can be
changed after installation within the "Database Connection preferences" on
page 85 (which can be accessed from either the "Server Configuration Settings" on
page 119 tool, or "Preferences" on page 80 window).

l

Test Connection button: Click to verify that the information provide into previous fields is
valid by connecting to the database.

Note
This test does not check whether the remote user has READ and WRITE
permissions to the tables under the objectiflune schema. It is solely a test of
database connectivity.

PlanetPress Connect Server Configuration
The Server Configuration page is where the Connect Server component is configured.
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Connect Server settings
The Connect Server settings are as follows:.
l

Run Server as: Defines the machine username and password that the Connect Server
module's service uses.

Note
The user account must have access rights to all local and network resources
required for production, as well as Windows "Log on as a Service" rights.
The user account selection must also be retained for future use, as the "Security
Settings" on page 138 dialog can only ever be executed through the user account
specified here.

l

l

l

Username: The account that the service uses to login. If the machine is on a
domain, use the format domain\username.
This account must be an existing Windows profile with local administrator rights.
Password: The password associated with the selected user.
Validate user button: Click to verify that the entered username and password
combination is correct and that the service is able to login.

Note
This button must be clicked and the user validated before the Next button
becomes available.

Click Next to display the Selection Confirmation page.

Selection Confirmation
This page confirms the installation selections made.
Click Next to start the installation itself. This process can take several minutes.
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Completing the installation
This screen describes a summary of the components that have been installed.
l

l

l

Configure Update Check checkbox: This option is enabled by default. It causes the
Product Update Manager to run after the installation is complete. This allows
configuring PlanetPress Connect to regularly check for entitled updates.
Note: this checkbox may not be available in the event that an issue was encountered
during the installation.
Show Log...: If an issue was encountered during the installation, click this button to
obtain details. This information can then be provided to Objectif Lune for troubleshooting.
When ready, click the Finish button to close the installation wizard, and initialize the
Product Update Manager, if it was selected.

The Product Update Manager
If the Configure Update Check option has been selected, a message will be displayed after
clicking “Finish” in the setup. The message details the information that needs to be sent back to
Objectif Lune Inc. in order to determine when/if the software needs updating.
Click “Yes” to install or open the Product Update Manager where the frequency with which the
updates can be checked and a proxy server (if required) can be specified.

Note
If the Product Update Manager was already installed by another Objectif Lune Inc.
application, it will be updated to the latest version and will retain the settings previously
specified.

Select the desired options and then click OK to query the server and obtain a list of any
updates that are available for your software.
l

l

Note that the Product Update Manager can also be called from the “Objectif Lune
Update Client” option in the Start menu.
It can be uninstalled via Control Panel | Programs | Programs and Features.
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Product Activation
After installation, it is necessary to activate the software. See Activating your license for more
information.
Before activating the software, please wait 5 minutes for the database to initialize. If the
software is activated and the services rebooted too quickly, the database can become
corrupted and require a re-installation.

Running Connect installer in Silent Mode
Updating to Connect 2019.1 from earlier Connect version
In order to update PlanetPress Connect to 2019.1 it is first necessary to update the Connect
License.
For details on how to upgrade the Connect License see "Users of Connect prior to 2019.1" on
page 60

Required and optional properties
PlanetPress Connect can be installed in a so called "silent mode" to allow an automated setup
during a company wide roll-out or comparable situations. The trigger for the Connect Installer to
run in silent mode is a text file with the fixed name install.properties, which is located either in
the same folder as the PlanetPress_Connect_Setup_x86_64.exe or in the unpacked folder of
the installer.exe.

Note
Only the installation can be run silently. Silent Mode does not apply to uninstalling,
modifying, or updating Connect. Any previous version of Connect must be uninstalled
before using the Silent Installer (see: "Uninstalling" on page 140).

The required properties file has the following attributes:
l

Comment Lines, starting with # (e.g. # The options to configure an external database)

l

Key = Value pairs (e.g. install.product.0 = Connect Designer)

For supported keys, please refer to the next paragraph.
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Note
The install.properties file notation must follow commons configuration rules. Please
refer to Properties files for more details.

Required and optional properties
Required properties depend on the specified product. Only fields related to that specified
product must be entered. If no product is mentioned, properties must be specified for all valid
Connect products.
Here is an example of an install.properties file.
# Verbose logging
logging.verbose = true
# Product selection
install.product.0 = Connect Designer
install.product.1 = Connect Server
# Server settings
server.runas.username = Localadmin
server.runas.password = admin
# Database configuration
database.type = mysql
database.host = 192.168.116.10
database.port = 3308
database.username = root
database.password = admin
database.schema = my_ol
Verbose logging (optional)
By default, the Silent Installer will log the same way as the GUI installer. That means logging
of error and warnings, and certain information during database configuration. A more verbose
logging can be switched on by using logging.verbose = true.
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Product selection (optional)
By default, if nothing is entered for the products to be installed (install.product.X), Silent
Installer will install all products which are visible to the user for the respective brand (except for
the Server Extension, because only Server or Server Extension can be installed at the same
time).
PlanetPress defaults
install.product.0 = Connect Designer
install.product.1 = Connect Server
install.product.2 = MySQL

Note
The values of install.product properties must contain the exact product names.

Server configuration (required if Server is selected for install)
For Server, the following properties need to be provided:
server.runas.username = <username>
server.runas.password = <password>
Server Extension configuration (required if Server Extension is selected for install)
For Server Extension, the following properties need to be provided:
server.runas.username = <username>
server.runas.password = <password>
server.master.host = <IP or name>
server.master.port = <port>
server.master.authenticate = true or false
server.master.username = <username for the Connect Server>
server.master.password = <password>
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Database configuration
Case 1: MySQL is among the selected Connect products to be installed (new MySQL
installation)
If MySQL is selected and there is no previous MySQL configuration on the machine, the
following properties should be defined:
database.password = <password> (required and must meet the rules)
database.port = <port> (3306 is the default port value)
database.unlocked = true or false (the default value is false,
optional)

Note
The unlocked option should only be used when the database requires an external
access.
If the Silent Installer runs with the default product selection, MySQL is included, and
hence the database.unlocked = true property may be optionally set if MySQL on this
machine is intended to serve as the central database also for remote machines.
If the Silent Installer runs with the explicit installation of a stand-alone (install.product.0 =
Connect Server), the database.unlocked property is irrelevant.

Note
The port will be defined automatically for the MySQL installation. All connect products
selected in the Silent Installer will automatically be configured to use the MySQL running
under the port defined by the database.port property, regardless of the default port 3306
or any other user defined port.
A different port is required if 3306 is already taken on that machine by another
application.
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Case 2: The Connect Server is selected and MySQL is not selected
In this case, an external database must be configured for the Server (and other Connect
products included in the Silent installation) to be used.
2a: Configuring an external MySQL database
To configure an external MySQL database, the following properties should be defined:
database.type = mysql (required)
database.host = <host> (default value is localhost, otherwise
required)
database.port = <port> (default value is 3306, otherwise required)
database.username = <username> (default value is root, otherwise
required)
database.password = <password> (required)
database.schema = <schema name> (default value is objectiflune,
optional)
2b: Configuring an external Microsoft SQL Server database

Note
Since PlanetPress Connect version 1.6 the minimum required version of the MS SQL
Server is SQL Server 2012.

To configure an external Microsoft SQL Server database, the following properties should be
defined:
database.type = Microsoft SQL Server (required)
database.host = <host> (default value is localhost, otherwise
required)
database.port = <port> (default value is 1433, otherwise required)
database.username = <username> (default value is sa, otherwise
required)
database.password = <password> (required)
database.schema = <schema name> (default value is objectiflune,
optional)
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Repository selection
The Connect installation process requires a repository from which the installer copies (locally)
or downloads (online installation) all selected Connect products.
In Silent Installer mode, the installation process looks for the property product.repository in
the install.properties file and then proceeds with the following steps:
1. If the property exists, and its value contains an existing file location with a repository, the
installer will attempt to install from that repository.
2. If the property exists, and its value starts with http://, the installer will attempt to install from
that location. It will fail if no repository can be found at this location.
3. If none of the conditions mentioned in the previous steps are met, the installer will look
next for a local "repository" folder (located in the same folder as the running Installer
(Setup) executable file). If a repository is found, the installer will attempt to install from that
repository.
4. As a last resort, the installer will attempt to install from the default Connect Update Site
URL.
Examples
product.repository = http://192.168.79.73/Connect/Version_
01/repository
product.repository = C:\\iso\\2.0.0.39695_unpacked\\repository
Locale definition
It is possible to define the Locale which affects the installation language and installed locale for
Connect products by using the following properties in the install.properties file:
user.language
user.country
Locales supported by Connect
The Connect Setup supports a dedicated list of Locales, which is saved in the preinstall.ini file.
Each entry consists of a language tag and a country tag, formatted by the pattern:
<language>-<country>
The current list of supported Locales is found below, but it may be enhanced in future releases:
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l

en-US (English, US)

l

de-DE (German, Germany)

l

fr-FR (French, France)

l

ja-JP (Japanese, Japan)

l

zh-CN (Chinese, China)

l

zh-HK (Chinese, Hongkong)

l

zh-MO (Chinese, Macau)

l

zh-TW (Chinese, Taiwan)

l

it-IT (Italian, Italy)

l

pt-BR (Portuguese, Brazil)

l

es-419 (Spanish, Latin America)

Locale selection by defining user.language and user.country
If both user.language and user.country are defined in the install.properties file, the
combination must match exactly one of the supported locales, otherwise the Installer will exit
with an error.
For example, user.language = fr and user.country = CA will cause an error since fr-CA is not
in the list of supported Locales.
Locale selection by defining only user.language
If only user.language is defined in the install.properties file, the Installer will attempt to find a
Locale in the list which starts with the given language code. The first match is selected for
installation. If no match is found, the Installer will exit with an error.
For example:
user.language = zh, will result in an installation with the Locale zh-CN
user.language = no, will result in an error
Default Locale selection
If neither user.language nor user.country is defined in the install.properties file, the Installer will
select a default Locale:
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1. If the System Locale is in the list of supported Locales, it will be selected.
2. Otherwise, if there is an entry in the list of supported Locales, which matches the System
language, it will be selected (e.g. on a fr-CA system, fr-FR is selected).
3. As last resort, the first Locale in the preinstall.ini is selected (usually that should be enUS).

Getting the exit code of a silent installation
If getting the exit code of a silent installation is desirable, use the following procedure.
1. Create a new local folder on the machine (or VM) on which Connect shall be installed
and copy/extract the contents of the Connect ISO into this folder.
2. Open a command prompt with Administrator privileges and use the "cd" command to
access this local folder.
3. Run this command to unpack the contents of the Connect Setup executable (as a sample,
we use the PReS Connect brand):
PReS_Connect_Setup_x86_64.exe -nr -gm2 -InstallPath=".\\"
4. In the local folder, the repository subfolder should now be located next to the
preinstall.exe, installer.exe and other Installer files.
5. Create the install.properties file for silent installation in the local folder.
6. With a batch file calling preinstall.exe and then querying the %errorlevel%, silent
installation can be started and the exit code can be evaluated. See the sample batch file
below.
Exit codes
0 = Success
1 = General Error in preinstall (e.g. not supported settings for user.language / user.country, for
reason see preinstall_err.log)
2 = Unknown Error in preinstall
10 = General Error in Installer application (for reason see OL_Install_<timestamp>.log)
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Sample batch file
@echo off
preinstall.exe
if errorlevel 10 goto err_installer
if errorlevel 2 goto err_unknown
if errorlevel 1 goto err_preinstall
echo Success
goto:eof
:err_installer
echo "Installer error - see OL_Install_<timestamp>.log"
goto:eof
:err_unknown
echo "Unknown preinstall error - see preinstall_err.log"
goto:eof
:err_preinstall
echo "Preinstall error - see preinstall_err.log"
goto:eof

Activating a License
PlanetPress Connect and PlanetPress Workflow both come with individual 30 day trial license
periods during which time it is not necessary to have a commercial license to run the
applications. This allows time for reviewing the applications and for organizing a commercial
license. If a modification to the trail license is required, such as to allow an extension to the trial
period, or for extra functionality, then a new activation code will need to be requested.

Obtaining the PlanetPress Connect Magic Number
To obtain an activation file the OL™ Magic Number must first be retrieved. The Magic Number
is a machine-specific code that is generated based on the computer's hardware and software
using a top-secret Objectif Lune family recipe. Each physical computer or virtual computer has
a different Magic Number, and each requires a separate license file to be functional.
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To get the PlanetPress Connect Magic Number open the Connect Software Activation
application.
l

Open the Start Menu

l

Click on All Programs and browse to the Objectif Lune folder.

l

Open the Connect Software Activation shortcut.

l

The PlanetPress Connect Software Activation application consists of the following:
l

License Information subsection:
l

l

l

Magic Number: Displays the PlanetPress Connect Magic Number.
Copy the magic number to the clipboard: Click to copy the Magic
Number to the clipboard. It can then be pasted in the activation request email
using the Windows CTRL+V keyboard shortcut.

Licensed Products subsection:
l

Name: Displays the name of the application or module relevant to this
activation.
The Information button
provides detailed information about the application
or module license.

l

l

l

l

l

l

l

Expiration Date: Displays the date when the activation will expire, or the
current date if the product is not activated.

End-User License Agreement - Appears only when loading a license file:
l

l

Serial Number: Displays the trial license serial number or the activation serial
number if the product has been activated in the past.

License: This box displays the EULA. Please note that this agreement is
legally binding.
I agree: Select to accept the EULA. This option must be selected to install the
license.
I don't agree: Select if you do not accept the EULA. You cannot install the
license if this option is selected.

Load License File: Click to browse to the Connect license file (.olconnectlicense),
once it has been received.
Install License - Active only when a license file is Loaded: Click to install the
license and activate the software.
Close: Click to cancel this dialog.
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Even if a license file has been Loaded, it will not be installed if this dialog is
Cancelled before the Install License button was clicked.

Requesting a license
After getting the Magic Number, a license request must be done for both PlanetPress Connect
and Workflow 8:
l

l

Customers must submit their Magic Number and serial number to Objectif Lune via the
Web Activations page: http://www.objectiflune.com/activations. The OL Customer Care
team will then send the PlanetPress Connect license file via email.
Resellers can create an evaluation license via the Objectif Lune Partner Portal by
following the instructions there: http://extranet.objectiflune.com/

Note that if you do not have a serial number, one will be issued to you by the OL Activations
team.
Accepting the license will activate it, after which the PlanetPress Connect services will need to
be restarted. Note that in some case the service may not restart on its own. To resolve this
issue, restart the computer, or start the service manually from the computer's Control Panel.

Activating PlanetPress Workflow 8
PlanetPress Workflow 8 uses the same licensing scheme as PlanetPress Connect. There are
two ways of activating the license for Workflow 8 after saving it to a suitable location:
l

l

If only PlanetPress Workflow 8 is installed, double-click on the license for the PlanetPress
Workflow 8 License Activation dialog to open. Applying the license here activates all of
the Workflow 8 components.
If you have both PlanetPress Workflow 8 and PlanetPress Connect installed, it will not be
possible to double-click on the license file as this will always open the PlanetPress
Connect Activations Tool. Instead, open PlanetPress Workflow 8 manually and apply the
license through the activations dialog within.

Activating PlanetPress Connect
To activate PlanetPress Connect, simply save the license file somewhere on your computer
where you can easily find it, such as on your desktop. You can then load the license by double-
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clicking on it, or through the PlanetPress Connect Software Activation tool.
Activating the PlanetPress Connect license requires the user to have local Windows
Administration rights.
l

Using a user profile that has local Windows Administration rights, open the Start Menu

l

Click on All Programs, then browse to the Objectif Lune folder.

l

Run the “Connect Software Activation” tool.

l

l

l

Click the Load License File button, and browse for the .olconnectlicense file you
received from Objectif Lune Inc..
Read the EULA and click the I agree option to accept it.
Click Install License to activate the license. The license will then be registered on the
computer and you will be able to start using the software.

Warning
After installation message will appear warning that the Server services will need to be
restarted. Just click OK to proceed.

Migrating to a new workstation
The purpose of this document is to provide a strategy for transferring a Connect installation to a
new workstation. The following guide applies to OLConnect v1.x/201x.x and Workflow
v8.x/201x.x.

Before installing the software
Before upgrading to a new version, even on a new workstation, consult the product's release
note to find out about new features, bug fixes, system requirements, known issues and much
more. Simply go to the product page and look for "Release notes" in the Downloads area.
You should also consult the following pages for some technical considerations before
installing:
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l

"Network Considerations" on page 20

l

"Database Considerations" on page 12

l

"Environment considerations" on page 17

l

"Installation Prerequisites" on page 28

l

"Antivirus Exclusions " on page 10

Downloading and installing the software
In order to migrate to a new workstation, the software must already be installed on the new
workstation. Follow the "Installation and Activation" on page 27 guide to download and install
the newest version of PlanetPress Connect on the new workstation.

Backing up files from the current workstation
The first step in migrating to a new workstation would be to make sure all necessary production
files and resources are backed up and copied over to the new system.

Note
Although it is not necessary to convert all of your documents when upgrading to the latest
version, we strongly recommended doing so. It is considered "Best Practice" to convert
the documents to the version installedand then re-send them to the Workflow Tools.

Backing up Workflow files
To save all Workflow-related files, backup the entire working directory:
C:\ProgramData\Objectif Lune\PlanetPress Workflow 8
Here are a few important points when transferring these files:
l

l

If you are upgrading to the latest version of Connect, it is recommended to open each
template in Designer, produce a proof making sure the output is correct. Then send the
template with its data mapping configuration, Job Creation and Output Creation preset
files to Workflow by clicking on File > Send to Workflow...
If you still use PlanetPress 7 legacy documents, PTK files can be imported by clicking on
the Workflow tool button at the top left corner of the Workflow tool interface. If copying the
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PlanetPress Workflow 8 folder directly, it's important to delete any file with the .ps7
extension so as to refresh the PostScript file for the new workstation. Deleting the .ps7
files will make Workflow recreate them.
l

l

The Workflow configuration file itself is named ppwatch.cfg, and is backed up with the
folders. However, it needs to be re-sent to the Service to be used. To do this, rename the
file to .OL-Workflow, open the file with the Workflow tool, and send the configuration.
Locate Custom Plugins (.dll) from the below folder on the old workstation and import them
onto the new workstation:
C:\Program Files (x86)\Common Files\Objectif Lune\PlanetPress
Workflow 8\Plugins
To import the plugins:
1. Start the Workflow Configuration Tool.
2. Click on the Plug-in Bar.
3. Click on the down pointing triangle under the Uncategorized group.
4. Select Import Plug-in and select the .dll file.

l

l

l

l

l

l

l

Import any external scripts used by the Run Script plugin, making sure they reflect the
same paths as on the previous workstation
Install any external application, executable and configuration files used by the External
Program plugin, making sure they reflect the same paths as on the previous workstation
Reconfigure local ODBC connections (i.e. create local copies of databases or recreate
required DSN entries).
Backup and import other custom configuration files, Microsoft Excel Lookup files, making
sure they reflect the same paths as previously.
Reinstall required external printer drivers and recreate all Windows printer queues and
TCPIP ports.
On the new workstation if the "TCP/IP Print Server" service is running in Windows, it is
requested to disable that service so that it does not interfere with the Workflow LPD/LPR
services.
Configure the Workflow services account as in the previous installation. If accessing,
reading and writing to network shares, it is recommended to use a domain user account
and make it a member of the local Administrators group on the new workstation. Once the
user account has been chosen:
1. Click on Tools in the Workflow Configuration menu bar.
2. Click Configure Services.
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3. Select the user account.
l

l

If required, grant permissions to other machines (Designer clients and other servers) to
send documents and jobs to the new server.
l

Click on Tools in the Workflow Configuration menu bar.

l

Click on Access Manager

l

Grant necessary permissions to remote machines.

l

Restart the Workflow Messenger service.

Reconfigure the Workflow Preferences as previously by clicking on the Workflow button
at the top left corner and clicking on Preferences:
l

l

l

l

Reconfigure the Server Connection Settings under Behavior > OL Connect.
For PlanetPress Capture users, reconfigure the PlanetPress Capture options under
Behavior > PlanetPress Capture.
Reconfigure each of the plugins, where necessary, under Plug-in as previously.
Capture OnTheGo users may want to enable the Use PHP Arrays option under
Plug-in > HTTP Server Input 1.
Send the configuration to the local Workflow service.

Backing up Connect Resources
The following resources are used by Connect and can be backed up from their respective
folders:
l

l

l

l

Job Presets (.OL-jobpreset):
C:\Users\
[UserName]\Connect\workspace\configurations\JobCreationConfig
Output Presets (.OL-outputpreset):
C:\Users\
[UserName]\Connect\workspace\configurations\PrinterDefinitionCo
nfig
OL Connect Print Manager Configuration files (.OL-ipdsprinter):
C:\Users\
[UserName]\Connect\workspace\configurations\PrinterConfig
OL Printer Definition Files (.OL-printerdef):
C:\Users\
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[UserName]\Connect\workspace\configurations\PrinterDefinitionCo
nfig
l

OMR Marks Configuration Files (.hcf):
C:\Users\[UserName]\Connect\workspace\configurations\HCFFiles

Where [username] needs to be replaced with your own Windows user name.
Other Resources
l

l

l

l

OL Connect Designer Templates , DataMapperor Package files, copied from the folder
where they reside.
All PostScript, TrueType, Open Type and other host based fonts used in templates must
be reinstalled on the new workstation.
Import all dynamic images and make sure their paths match those in the old server.
Make sure the new workstation can also access network or remote images, JavaScript,
CSS, JSON, and HTML resources referenced in the Connect templates.

Secondary software and licenses
The following only applies to specific secondary products and licenses that interact or are
integrated into the main product.
Image, Fax and Search Modules
l
l

Reconfigure the Image and Fax outputs with the new host information.
Import the Search Profile and rebuild the database in order to generate the database
structure required by the Workflow.

Capture
1. Download the latest version of the Anoto PenDirector.
2. Before installing the PenDirector, make sure the pen’s docking station isn’t plugged into
the server. Then install the PenDirector.
3. Stop the Messenger 8 service on the old and new server from the Workflow menu
bar: Tools > Service Console > Messenger > right-click and select Stop.
4. Import the following files and folders from the old server into their equivalent location on
the new server:
C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress
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Watch\capture\PPCaptureDefault.mdb
C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress
Watch\DocumentManager
C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress
Watch\PGC
5. If Capture was previously using an external MySQL or Microsoft SQL Server, reconfigure
the ODBC connection details as previously from the Workflow Preferences by clicking on
the Workflow button at the top left corner and clicking on Preferences, then reconfigure
the PlanetPress Capture options under Behavior >PlanetPress Capture > Use ODBC
Database.
6. Start the Messenger 8 service on new server from the Workflow menu bar: Tools >
Service Console > Messenger > right-click and select Start.
OL Connect Send
l

l
l

As of version 8.6 the Connect Send plugins are installed automatically with Workflow. If
you are using an older version, run the OL Connect Send Plug-in Installer on the new
Workstation to re-install the Connect Send plugins.
Reconfigure the Server URL and port during the OL Connect Send Printer Driver setup.
Re-run the OL Connect Send printer driver setup on client system and select the Repair
option to point the clients to the new Server URL.

Configuring the Connect Engines
Any changes made to the Server preferences require the OLConnect_Server service to be
restarted to take effect.
1. Stop the OLConnect_Server service from Control Panel > Administrative Tools >
Services > OLConnect_Server > Stop.
2. Configure the Merge and Weaver Engines scheduling preferences as in the previous
installation
l

l

Open the Server Configuration from:
C:\Program Files\Objectif Lune\OL Connect\Connect Server
Configuration\ServerConfig.exe
Configure the DataMapper, Merge and Weaver engines preferences under
Scheduling (see Engine Setup preferences). As of version 2018.1 these
preferences include the minimum (Xms) and maximum (Xmx) memory utilization for
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the Server, Merge and Weaver engines .
l

Configure any other options for the Clean-up Service.

3. If the version used on the new machine is 1.8/8.8 or older, you may have to manually
configure the minimum (Xms) and maximum (Xmx) memory utilization for the Server,
Merge and Weaver engines as previously or better (see also: "Memory per engine" on
page 125):
l

Edit the Xms (minimum RAM size) and Xmx (maximum RAM size) fields in the
following configuration files:
l

C:\Program Files\Objectif Lune\OL Connect\Connect
Server\Server.ini

l

C:\Program Files\Objectif Lune\OL Connect\Connect Merge
Engine\MergeEngine.ini

l

C:\Program Files\Objectif Lune\OL Connect\Connect
Weaver Engine\WeaverEngine.ini

4. Now start the OLConnect_Server service
Configuring the Server Extensions
In the case where the OLConnect MySQL is installed on the new Master Server, it is important
to reconnect all Server Extension systems to the new Master Server.
Perform the following action on each Server Extension:
1. Stop the OLConnect_ServerExtension service from Control Panel > Administrative
Tools > Services > OLConnect_ServerExtension > Stop.
2. Open the Server Extension Configuration from:
C:\Program Files\Objectif Lune\OL Connect\Connect Server
Extension\ServerExtension.exe
3. Click on Database Connection and configure the JDBC Database connection settings so
that the hostname points to the new Master Server.
4. Click on Scheduling and type in the location of the new Master Server.
5. Start the OLConnect_ServerExtension service.
Transferring software licenses
Once all the above resources have been transferred over to the new server, it is recommended
to thoroughly test the new system - in demo mode - with sample files under normal production
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load to identify points of improvement and make sure the output matches the user’s
expectation.
Output generated at this point will normally bear a watermark which can be removed by
transferring licenses from the old server to the new one.
l

l

l

To transfer Connect and Workflow licenses, the user is usually required to complete a
License Transfer Agreement which can be obtained from their local Customer Care
department.
If you want to transfer your licenses to the new machine right away, you may ask your
local Customer Care department for a 30day Transition activation code for your old
machine.
Upgrades cannot be activated using the automated Activation Manager. Contact your
local Customer Care department.

To apply the license file received from the Activation Team:
1. Ensure that all services are stopped on your old machine before activating and starting
the services on the new machine. Attempting to run the software with the same license
simultaneously will not only run into errors but it is a breach of our EULA.
2. Start the PReS Connect, PlanetPress Connect or PrintShopMail Connect Software
Activation module:
C:\Program Files\Objectif Lune\OL Connect\Connect Software
Activation\SoftwareActivation.exe
3. Click on Load License File to import the license.OLConnectLicense.
4. Start the Software Activation module on the Extension servers, where applicable.
5. Click on Load License File to import the above same license.OLConnectLicense.
6. Restart the OLConnect_Server service and restart the OLConnectServer_Extension
service on the Extension servers, where applicable.
7. The number of Expected Remote Merge and Weaver engines should now be
configurable in the Connect Server Configuration module (C:\Program
Files\Objectif Lune\OL Connect\Connect Server
Configuration\ServerConfig.exe)
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To apply the PlanetPress Capture License:
1. Open the Workflow Configuration.
2. Click on Help on the Menu Bar and click on PlanetPress Capture License manager to
import your license.
Uninstalling PlanetPress Connect from the previous workstation
It is recommended to keep the previous install for a few days until everything is completed.
However, once your transition is successful and complete, the OL Connect software must be
uninstalled from the original server. See "Uninstalling" on page 140.

Information about PlanetPress Workflow
If you wish to use PlanetPress Workflow (automation) in conjunction with PlanetPress Connect,
you will need to install PlanetPress Workflow 2019.1 as well. Workflow 2019.1 is provided
through a separate installer which is available on CD or for download as follows:
l

l

If you are a Customer, the installer can be downloaded from the Objectif Lune Web
Activations page: http://www.objectiflune.com/activations
If you are a Reseller, the installer can be downloaded from the Objectif Lune Partner
Portal: http://extranet.objectiflune.com/

PlanetPress Workflow can be installed in parallel on the same machine as an existing
PlanetPress® Suite 7.x installation.
Note however:
l

l

l

If both versions need to be hosted on the same machine, PlanetPress Workflow 2019.1
must always be installed after the legacy PlanetPress® Suite 7.x installation.
When uninstalling PlanetPress Workflow 2019.1, you may be prompted to repair your
legacy PlanetPress® Suite 7.x installation.
If PlanetPress Workflow 2019.1 has been installed alongside PlanetPress® Suite 7,
Capture can no longer be used with Workflow 7.
The plugins are now registered uniquely to Workflow 2019.1 and the messenger for
Workflow 7 is taken offline. It is only then possible to use Capture from PlanetPress
Workflow 2019.1.
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l

l

PlanetPress Workflow 2019.1 and PlanetPress® Suite Workflow 7 cannot run
simultaneously, since only one version of the Messenger service can run at a time. In fact,
no two versions of Workflow can be run simultaneously on the same machine, regardless
of versions.
It is possible to switch between different versions running by shutting down one version's
services and then starting the other. However, this is not recommended. There are no
technical limitations that prevent processes from previous PlanetPress Suite Workflow
versions (as far back as Version 4) to run on PlanetPress Workflow 2019.1, removing the
need to run both versions.

For more information on the licensing of Workflow 2019.1, please see Activating your license.

Upgrading
This page provides information about Upgrading to PlanetPress Connect version 2019.1.
Upgrade information is detailed in the following pages:
l

"Upgrading from previous Connect Versions" below

l

"Upgrading from PReS Classic" on page 62

l

"Upgrading from PlanetPress Suite 6/7" on page 62
l

"How to perform a Workflow migration" on page 71

l

"How to perform a Capture migration" on page 75

Upgrading from previous Connect Versions
Users of Connect prior to 2019.1
Users of Connect 1.0 should see "Users of Connect 1.0" on page 62 first.
Users of Connect 1.1 should see "Users of Connect 1.1" on the next page first.
Users of all other Connect versions prior to 2019.1 should note that Update Client 1.2.40 is a
prerequisite for both OL Connect 2019.1 and Connect Workflow 2019.1 installations. Only
Update Client 1.2.40 has the capacity to upgrade the OL Connect license to the newer format
that is required by the installers of those products.
If you do not have Update Client version 1.2.40 installed already, then the next time you run
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your Update Client it will show that there is an update available of itself to Version 1.2.40 (or
later).
Simply click on the “Install” icon

to initiate the upgrade.

For further details on how to upgrade the Update Client and update your Connect License see
the Update Client 1.2.40 Upgrade Guide.
Note that an erroneous or incomplete uninstall before a reinstall or upgrade to a newer version
of OL Connect may cause issues (see Product or engine exits within a second of starting in
Connect's Knowledge Base).

Note
If an error occurs during uninstallation or after/when re-installing Connect after uninstalling it,
please see: Problems during a Connect installation or version upgrade in Connect's
Knowledge Base.

Users of Connect 1.1
In order for users of PlanetPress Connect 1.1 to upgrade to any later version through the
Update Manager it is necessary to install a later version (1.1.8 or later) of the Objectif Lune
Update Client.
If you do not have such a version installed already, the next time you run your Update Client it
will show that there is an update available of itself to Version 1.1.8 (or later).
Simply click on the download button in the dialog to install the new version of the Update
Client. Note that it is no problem to run the update while the Client is open. It will automatically
update itself.
Once you have done this, PlanetPress Connect2019.1 will become available for download.

Note
From PlanetPress Connect Version 1.2 onwards, the new version (1.1.8) of the Update
Client is included by default with all setups.
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Users of Connect 1.0
Users of Connect version 1.0 cannot upgrade directly to Version 2019.1. This is because
Connect Version 1.0 is a 32 bit version of Connect.
Users must first upgrade to Version 1.1 and from there upgrade to Version 2019.1
If you are updating manually you must first upgrade to Version 1.1 before installing 2019.1. If
you attempt to go directly from Version 1.0 to Version 2019.1 the installation will fail.
Also see "Users of Connect 1.1" on the previous page for extra information about updating from
that version.

Upgrading from PReS Classic
PReS Classic and PlanetPress Connect are very different products.
Whilst PlanetPress Connect provides considerably more options for email and web output, one
need not abandon existing PReS Classic print jobs. They can still be run through Connect
Workflow, via the PReS Print Controls task.

Upgrading from PlanetPress Suite 6/7
Note
This document is intended for people who already received their upgrade to PlanetPress Connect.
They should already have their new serial number(s) in hand and the PlanetPress Connect installers.

PlanetPress Connect, Objectif Lune’s innovative technology, embodies a true Production Print
as well as an Interactive Business Communication Solution.
This document provides information on the migration process and the requirements and
considerations for existing PlanetPress Suite users to upgrade to the latest generation of our
products.
What does PlanetPress Connect contain?
PlanetPress Connect is comprised of the following modules:
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l

PlanetPress Workflow 2019.1. This is the natural evolution of PlanetPress Suite
Workflow 7 (Watch, Office or Production). PlanetPress Workflow 2019.1 is very similar to
the PlanetPress Suite Workflow 7 version but contains a number of new features and has
the ability to run PlanetPress Connect jobs, as well as PlanetPress Suite, PrintShop Mail
Suite and PReS Classic documents.
l

Imaging for PlanetPress Connect is available as an option. It contains:
l

PlanetPress Fax

l

PlanetPress Image

l

PlanetPress Search

IMPORTANT: If you owned them, you must also upgrade your Imaging modules to
use the new version.
l

l

l

PlanetPress Capture is still supported in PlanetPress Workflow 2019.1 but only with
documents created with the PlanetPress Suite Design 7.

PlanetPress Connect Designer. This is a design tool based on completely new
technology. It is not backwards compatible and therefore cannot open PlanetPress Suite
Design 7 documents. If you want to continue editing those documents you can keep doing
so in PlanetPress Suite Design 7.
PlanetPress Connect Server. This is the core of the Connect technology (see Connect: a
peek under the hood). This new module automates the merging of data with your new
templates and generates the output. It is required for PlanetPress Workflow 2019.1 to
handle templates created with the PlanetPress Connect Designer. It can be installed on
the same or a different machine as PlanetPress Workflow 2019.1.

IMPORTANT: PlanetPress Connect does not contain the PlanetPress Design 7.
PlanetPress Connect does not need any printer licenses to print from PlanetPress Connect
or PlanetPress Suite. It can also print PrintShop Mail 7 and PReS Classic documents if
these programs are licensed.
You can keep everything you have
The first thing to know is that you can keep your current PlanetPress Suite Workflow 7
configuration and your PlanetPress Suite Design documents. When upgrading to PlanetPress
Connect, they will remain functional.
Please note that PlanetPress Suite Workflow 7 and PlanetPress Workflow 8 cannot run at the
same time. See Information about Connect Workflow 8 for information about these limitations.
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The only exception is the PlanetPress Suite Design tool that you can continue to use as it is not
part of PlanetPress Connect.
PlanetPress Connect installation considerations
The PlanetPress Suite could run on a computer with a minimum of only 1GB of RAM available.
The PlanetPress Connect Server with PlanetPress Workflow 2019.1, by default, requires 8GB
of RAM, but if you intend on using the new PlanetPress Connect Designer on the same
computer, you should consider having at least 16GB of RAM available. See System
requirements.
Distributed installation or not
You can decide to install PlanetPress Connect modules all on the same computer or have each
module on a different computer. Reasons for this could be:
l

l

There is insufficient memory in the computer currently running PlanetPress Workflow
2019.1 to also run PlanetPress Connect Server.
You want to use a more powerful computer with more RAM and more cores to run the
Server to achieve maximum performance (see "Performance considerations" on
page 20).

What do I gain by upgrading to PlanetPress Connect?
When upgrading to PlanetPress Connect, PlanetPress Watch users receive key features of
PlanetPress Office such as the following:
l
l

l
l

l

Ability to input data from PDF
Ability to print your PlanetPress Suite documents on any Windows printer (no need for
printer licenses)
Ability to create standard PDF output from your PlanetPress Suite documents
Even if you don’t recreate your existing PlanetPress Suite documents, you can easily
change your workflow to convert your output to PDF, then output them in PCL to any
device supporting it.
The full version of PlanetPress Connect can open your company to the digital world by
enabling you to send HTML responsive emails as well as creating dynamic responses
and interactive web pages.
You can reuse the content of your existing documents and map it onto responsive
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documents that can be sent by email in full HTML glory and/or make them available as
native HTML web pages using the latest CSS/JavaScript features.

Note
If you were a PlanetPress Production user, you retain all functionalities within PlanetPress
Workflow 2019.1. These are automatically imported during the activation (see below).

Create new documents and integrate them into your workflow at your own pace
You can start benefiting from the innovative technology of the new PlanetPress Connect
Designer right away by designing new documents, or re-doing existing ones at your own pace.
You can also now:
l

l

l

Use the new DataMapper to easily map any input data into a clean data model that any
designer person can use.
Easily create documents with tables that spread over multiple print pages, respecting
widow and orphan rules, displaying sub-totals and totals properly.
Have text that wraps around images.

Upgrade steps
1. To upgrade to PlanetPress Connect, the first step is to stop your PlanetPress Workflow
services. You can do so from the PlanetPress Workflow configuration tool or from the
Windows Service Management console.
2. Then, using the PlanetPress Connect setup, install the Designer and/or Server on the
appropriate computers.
3. Then, using the PlanetPress Workflow 2019.1 setup, install PlanetPress Workflow and/or
PlanetPress Image on the appropriate computers. (See "Installation and Activation" on
page 27 for more details.)

Note
If Workflow installation finds that .NET 4.0 is not already installed, it will install that version
as part of the setup process.
If LaserFiche or the ICR libraries are chosen as part of the Workflow installation, then .NET
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3.5 must also be installed. This will need to be installed manually, as .NET 3.5 is not included
in the Workflow setup.

4. If you installed PlanetPress Workflow 2019.1 on the same computer where you had
PlanetPress Suite Workflow 6 or 7, you can use the Upgrade Wizard to import your:
l

PlanetPress Workflow:
l

Processes configuration

l

PlanetPress Suite compiled documents

l

Service configuration

l

Access manager configuration

l

Custom plug-ins

l

PlanetPress Fax settings

l

PlanetPress Image settings

l

PlanetPress Search profiles

l

Printer activation codes

l

PlanetPress Capture database

l

PlanetPress Capture pen licenses

l

Custom scripts

l

Content of your virtual drive

l

PlanetPress Messenger configuration

5. If you installed PlanetPress Workflow 2019.1 on a different computer, please see "How to
perform a Workflow migration" on page 71 for help importing all those settings, if you wish
to import them.
6. To launch the Upgrade wizard, open the PlanetPress Workflow 8 configuration tool and,
from the Tools menu, launch the Upgrade Wizard.
IMPORTANT: Before you start this process, make sure you have a backup of your current
installation/computer.
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7. Then select your upgrade type:

Page 67

8. Then select the product from which you wish to upgrade:

9. If you selected to do a Custom upgrade, select the required options:
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10. Then finally review the log in the final dialog for details on how it went:
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11. After that you will need to get the activation file for your product.
To obtain your activation, download the PlanetPress Connect installer from the Web
Activation Manager, follow the instructions for the installation using the serial number
provided to you. You can activate your license through the Web Activation Manager.
12. From now on, if you need to modify your PlanetPress Design documents, simply open
PlanetPress Design 6 or 7, edit your document and send the updated version to
PlanetPress Workflow 8. In order to do that:
l

l

If you have PlanetPress Design on the same computer as PlanetPress Workflow
2019.1, you need to save the documents to PTK by using the “Send to” menu, then
"PlanetPress Workflow”, and there use the “Save to file” button. Then, from the
PlanetPress Workflow configuration tool, in the “Import” menu, select “Import a
PlanetPress Document” and select the previously saved file.
If you have PlanetPress Design on a computer and PlanetPress Workflow 2019.1
on another, you can simply use the “Send to” menu in the Designer and select the
PlanetPress Workflow tool to which you want to send the PlanetPress Design
document.
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How to perform a Workflow migration
What do you need to consider when upgrading from PlanetPress Suite 7 to PlanetPress
Connect Workflow 2019.1 on a new computer?
Installing and Activating Workflow 2019.1 on a new computer
Points to consider:
l

l

l

l

Before installing, be sure to read the Installation and Activation Guide. There you will find
detailed Connect Workflow installation steps as well as system requirements, notes on
license activation and much more.
It is recommended you retain your existing PlanetPress Suite installation for a period of
time after the PlanetPress Connect Workflow 2019.1 installation. We recommend this
particularly when undertaking migration from one to the other. Once the migration has
completed, you should uninstall PlanetPress Suite from your original installation. In the
meantime, a fresh installation of PlanetPress Connect will run for 30 days without
requiring an activation code, to simplify the migration process.
Request new activation codes for your software licenses (License Transfer agreement
needs to be filled out and signed). Contact your local Activations Department.
www.objectiflune.com/activations
Please note that PlanetPress Suite Workflow 7 and PlanetPress Workflow 8 cannot run at
the same time. See Information about Connect Workflow 8 for information about these
limitations. The only exception is the PlanetPress Suite Design tool that you can continue
to use as it is not part of PlanetPress Connect.

Printer Licences
If you are currently using Printer Licenses under PlanetPress Suite 7 and wish to continue
doing so in PlanetPress Connect Workflow 2019.1, there are a few ways in which you can
reinstall those printer activation codes onto PlanetPress Connect Workflow 2019.1. They are as
follows:
l

If you retained the .pac file (printer activation codes) from your previous installation, then
double click on that file from within your new computer, and the printers will get activated.
If you did not retain the pac file, you can export a new printer activation code. This is done
from the PlanetPress Suite Designer Help > Printer Activation menu option. When the
"Activate a printer" dialog is launched, right click within it and select the Export context
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menu option, then save the file on the new computer. Double clicking on the .pac file will
then activate all of your printers on the new computer.
l

l

Login to our Web Activation Manager (www.objectiflune.com/activations) using your
customer number and password to get your Printer Activation Codes.
If you do not have access to the computer in which PlanetPress Suite was previously
installed, print a Status Page for each printer from your Connect Workflow 8
Configuration. Do this via the Tools > Printer Utilities menu option. Select “Print Status
Page” and then select your printers from the list.
Email the Status Page(s) to activations@ca.objectiflune.com and you will receive a .pac
file in return, with which you can activate your printer(s).

Documents and Resources
PlanetPress Suite Documents and Resources
l

l

l

Backup all your PlanetPress Suite Design documents from your old computer and copy
them onto the new computer. The files use the extension .ppX, where X is the version
number of the PlanetPress Suite that created the files.
The documents do not have to be in any specific folder.
Back up the entire directory of: "C:\ProgramData\Objectif Lune\PlanetPress Suite
7\PlanetPress Watch\Documents".
This folder contains all the PlanetPress Design documents and compiled forms (*.ptk and
*.ptz).
Paste the files onto the new computer in the following folder:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\Documents"
Back up the latest .pwX (PlanetPress Workflow Tools Configuration) file, found here:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\".
Paste onto the new computer in the following folder:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\"

There are several ways you can import Documents into PlanetPress Workflow. They are as
follows.
1. In Connect Workflow go to File > Import > PlanetPress Document … and select the .ptk
document you wish to import.
These files will most likely be found in the Documents folder on the PlanetPress Suite
computer:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\Documents"
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2. Copy all the PlanetPress Suite 7 Documents and Compiled forms (*.ptk and *.ptz) from
the Documents folder on the PlanetPress Suite computer and paste them into the
equivalent folder on the Connect Workflow Computer.
The PlanetPress Suite 7 folder would be "C:\ProgramData\Objectif Lune\PlanetPress
Suite 7\PlanetPress Watch\Documents".
The PlanetPress Connect Workflow 8 folder will be "C:\ProgramData\Objectif
Lune\PlanetPress Workflow 8\PlanetPress Watch\Documents"
3. Use the File > Send To menu option in PlanetPress Suite Designer and select the
PlanetPress Connect Workflow 8 to which you want to send the PlanetPress Suite
Designer document.
This should work with PlanetPress Suite versions 6 and 7.
Make sure that ports 5863 and 5864 are not blocked by firewall on either machine.
Also make sure you add the PlanetPress Suite machine’s IP address to the permissions
list in Connect Workflow 8 from Tools > Access Manager.
Further information about Workflow Access Manager can be found here: Access
Manager.
Windows Operating System Steps:
l

l

l

l

Install all the Windows printer queues from the old computer, making sure they are named
the same.
If your existing documents referenced any local dynamic image resources in a folder or in
Local Host, make sure that you import them onto the new computer as well, or make them
available on a network accessible drive.
Any special PostScript or TrueType fonts used will also need be installed on the new
computer.
Verify that you have access to any other resources that the PlanetPress Suite used. This
includes network folders, printers, third party software and the like.

Workflow Plug-ins
Back up any custom PlanetPress Suite Workflow configuration Plug-ins (.dll) and copy them
onto the new computer.
The PlanetPress Suite Workflow plug-ins folder can be found here:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\Plugins".
Make sure that you copy only the custom plug-ins.
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Alternatively, you can download custom plug-ins from this link onto the new computer.
Once you've copied your PlanetPress Suite Workflow configurations to Connect Workflow, you
can confirm their availability through the Plug-in Bar Uncategorized category. There you will
find all the Custom plug-ins that have been installed.
Missing plug-ins will be represented in Workflow steps through the use of a "?" icon. Such as in
the following image, which shows that the "TelescopingSortPlugin" is not installed.

To import a plugin:
1. Click on the popup control ( ) in the Plug-in bar.
2. Select Import Plugin
3. Browse to the location of the plug-in DLL file
4. Click on Open.
5. The new plug-in should appear in the Plug-in Bar Uncategorized category.
Configuring PlanetPress Connect Workflow 8
l

l

l

l

l

Reconfigure any settings that may need to be applied to the PlanetPress Suite
Messenger and PlanetPress Workflow Tools LPD services using the Access Manager.
All PostScript and TrueType host based fonts must be reinstalled. Make sure you restart
the computer after this step.
If necessary, reconfigure local ODBC connections. (i.e. create local copies of databases
or recreate required DSN entries)
Manually install all external executables that will be referenced by the Connect Workflow
processes in the configuration file. If possible, retain the local path structure as used on
the older installation.
If the Windows "TCP/IP Print Server" service is running on the new computer, it is
recommended that you disable the Server so that it does not interfere with the
PlanetPress LPD/LPR services.
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l

l

l

If you are using images from a virtual drive, copy the entire contents of
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PSRIP" and paste them onto the new
computer here: "C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PSRIP".
Make sure to set the user who will run the PlanetPress Services. This is done by going
into Tools/Configure services. The user will need to have local administration rights in
order to be able to run the services.
For more information, see Users and Configurations.
Once all these steps have been completed, you will need to import your configuration file.
Find the latest pwX file located on the old computer, if it is not already copied across to
the new computer. The default location on the old computer is “C:\ProgramData\Objectif
Lune\PlanetPress Suite 7\PlanetPress Watch\”.
On the new computer you will need to go to File > Import > Configuration Components.
Browse and find your file. If the file is not visible change the file type to *.pw7

PlanetPress Image, Fax and Search
l

l

Reconfigure the PlanetPress Image and PlanetPress Fax outputs with the new host
information.
You must import the Search Profile and rebuild the database in order to generate the
required database structure.

PlanetPress Capture
l

If you have a Capture Solution, please see "How to perform a Capture migration" below.

How to perform a Capture migration
This page provides information on how to conduct a proper migration of a Capture solution.
These steps must be executed after a proper Workflow Migration has been completed.
Instructions on how to do such can be found here: "How to perform a Workflow migration" on
page 71.
Failure to do so will result in unexpected problems.
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Note
It is recommended that you first update your PlanetPress Suite to version 7.6 before
cross-grading to PlanetPress Connect.

Using PlanetPress Connect Workflow 2019.1 on the same computer as PlanetPress
Suite 7.6
Steps to migrate:
1. Update existing installation to PlanetPress Suite version 7.6 if not already done.
2. Install PlanetPress Connect Workflow 2019.1 on the same computer.
3. Do the following for both PlanetPress Suite version 7.6 and PlanetPress Connect
Workflow 8.
1. Open Workflow Service Console. This can be done either via the Windows Start
Menu, or from within Workflow Configuration application (via menu option Tools
> Service Console).
2. Select Messenger in the tree list, right click and select

Stop from the context

menu.

Note
These steps must be done for both PlanetPress Suite Workflow 7 and
PlanetPress Connect Workflow 8.

4. Copy the file PPCaptureDefault.mdb from this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\capture"
to this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\capture" and
overwrite the existing database.
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Note
Prior to PlanetPress Suite 7.6, all Capture patterns, documents and several other
details were contained within the one single database. As of PlanetPress Suite 7.6
a separate database has been used for the patterns alone
(PPCaptureDefault.mdb).

5. Copy the contents of this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress
Watch\DocumentManager"
to this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress
Watch\DocumentManager".
6. Copy the contents of this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\PGC"
to this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\PGC"
7. Restart the PlanetPress Connect Workflow 8 Messenger. To do this,
1. Open Workflow Service Console. This can be done either via the Windows Start
Menu, or from within Workflow Configuration application (via menu option Tools
> Service Console).
2. Select Messenger in the tree list, right click and select

Start from the context

menu options.
8. Contact your local Objectif Lune activation team and transfer any Pen(s) licenses across.

Using PlanetPress Connect Workflow 2019.1 on a different computer to PlanetPress
Suite 7.6

Tip
It is safer to migrate outside high peak production since the Capture solution cannot be
run in parallel on two computers.
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Once the Capture database has been transferred to the new computer, any update made
to the old computer will be lost unless the steps to migrate are reproduce again.
Once a Pen has been docked and the data transfer done, its memory is wiped, thus
rending the parallel mode very hard to produce. It is not impossible, but describing how it
can be done is beyond the scope of this migration article.

Steps to migrate:
1. Update existing installation to PlanetPress Suite version 7.6 if not already done.
2. Install PlanetPress Connect Workflow 2019.1 on new computer.
3. The Anoto PenDirector must be installed. It if is not, you can download it from here and
then install it.

Note
It is strongly recommended that you install the latest version of the PenDirector.
Please use the link provided on the previous line.
Do not get any other version of the PenDirector from the Anoto website, as
they will not have been set up correctly for our Capture solution.

Note
Prior to installation, make sure you unplug the Pen docking station from the USB
port on the computer where you are about to install the Anoto PenDirector.

4. Do the following for both PlanetPress Suite version 7.6 and PlanetPress Connect
Workflow 8.
1. Open Workflow Service Console. This can be done either via the Windows Start
Menu, or from within Workflow Configuration application (via menu option Tools
> Service Console).
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2. Select Messenger in the tree list, right click and select

Stop from the context

menu.

Note
These steps must be done for both PlanetPress Suite Workflow 7 and
PlanetPress Connect Workflow 8.

5. Copy the file PPCaptureDefault.mdb from this folder on the PlanetPress Suite 7.6
computer:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\capture"
to this folder on the new PlanetPress Connect Workflow 2019.1 computer:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\capture" and
overwrite the existing database.

Note
Prior to PlanetPress Suite 7.6, all Capture patterns, documents and several other
details were contained within the one single database. As of PlanetPress Suite 7.6
a separate database has been used for the patterns alone
(PPCaptureDefault.mdb).

6. Copy the contents of this folder on the PlanetPress Suite 7.6 computer:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress
Watch\DocumentManager"
to this folder on the new PlanetPress Connect Workflow 2019.1 computer:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress
Watch\DocumentManager".
7. Copy the contents of this folder on the PlanetPress Suite 7.6 computer:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\PGC"
to this folder on the new PlanetPress Connect Workflow 2019.1 computer:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\PGC"
8. Restart the PlanetPress Connect Workflow 8 Messenger. To do this,
1. Open Workflow Service Console. This can be done either via the Windows Start
Menu, or from within Workflow Configuration application (via menu option Tools
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> Service Console).
2. Select Messenger in the tree list, right click and select

Start from the context

menu options.
9. Contact your local Objectif Lune activation team and transfer any Pen(s) licenses across.

Preferences
The Preferences dialog is used to modify the general software preferences. Changes made in
this dialog affect the software globally, not individual templates and data mapping
configurations.
The Preferences dialog is separated into individual tabs, where each tab controls certain
aspects of the software.
To open the Preferences dialog, select Window > Preferences.

General preferences
The General Preferences are as follows:
l

Always run in background: This option correlates with the "Always run in background"
option selectable in the "Document Boundaries Refresh" dialog and "Print via Print
Server" dialog. When either of these dialogs is used and the option is checked, it will also
be checked here. To prevent the refresh boundaries and print via print server dialogs to
automatically run as background, uncheck this option.

The General Preferences also provides you with buttons to :
l

l

l

Reset all Warning Dialogs: This re-enables all warning dialogs that might have been
previously disabled by selecting the "Don't show again" checkbox within the dialog.
Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.
Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.
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------------------------------------------------------------------------------------------

COTG Servers preferences
This option allows one or more Capture OnTheGo servers to be set up, in order to be used with
the Capture OnTheGo WIM product.
l

Name: Enter a unique name.

l

URL: Enter a valid URL (including the protocol, e.g. http://).

l

Restore Defaults: Removes all custom servers from the list and resets to the default
Capture OnTheGo server.

The COTG Servers Preferences also provides you with buttons to :
l

l

Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.
Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

------------------------------------------------------------------------------------------

Clean-up Service preferences
The Clean-up Service defines how the Connect database and the temporary files created
during Connect production runs are cleaned up after the production run has finished.
As part of the job production process PlanetPress Connect uses a database for intermediate
storage and also creates various temporary "managed" files. These files include data
extractions, configuration files and any intermediate files created during the production process.
Connect keeps track of all these files through references held within the Connect database.
All the files created and the database references to them are stored for a set amount of time in
order to allow Connect to reuse them. However, we do not want to store these indefinitely,
because the database would run out of space. The solution is to use the "Clean-up Service" to
remove the temporary data and files once they are no longer needed. This clean-up service is
usually managed by the Server Engine.
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The more items that are present in the database, and the larger they are, the more time and
processing power (CPU) that will be required for cleaning them up. Thus a regular Clean-up of
the database (as often as possible) is recommended.
This is especially the case if items are not going to be retrieved from the database at a later
date. i.e. If the Connect job is not going to be re-run.
The clean-up can always be set to run outside of business hours (see the Run according to
the cron schedule option below), to reduce impact upon Production systems.
The values below define when the specified targets are to be set as being ready for deletion,
not when they are actually deleted. The actual deletion occurs only as per the cron job
scheduling; or when PlanetPress Connect is started (if Run at application start up is
selected); or when the Run Now button is pressed.
l

l

l

Enable clean-up service: Check to enable the Clean-up services. When checked, either
or both of the Database clean-up and File clean-up services can be set individually.
If the box is not checked, then no Clean-up will occur.
Run at application start up: Click to start the clean-up service when the Designer
module is opened, or the Managing Service is started.
Run according to the cron schedule: Enter the interval at which the Clean-up service
runs.
To understand how to write a cron job schedule, please refer to the Quartz Scheduler
tutorial.

Note
If the Product managing the service is set to Designer, then the Designer must be
running at the time that the cron job is scheduled, for the Clean-up to run.

l

Product managing the service: Select which of the applications will run the service.
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Note
The Server Engine is set as the default as it is generally considered the best
option.
This is particularly the case when using a scheduled cron job, as the Sever Engine
is always running, whilst the Designer might well not be at the scheduled time (in
which case the clean-up will fail to run).

l

Database Clean-up Service:
l

Allow database clean-up service: Select this checkbox to enable the database
Clean-up settings, and enable the actual clean-up.
l

Threads to use for database deletions: The number of Threads to be used
in the clean-up. PlanetPress Connect is a multi-threaded application, and the
clean-up is likewise.

Tip
The default number of threads is considered the best compromise for
running both clean-up and production jobs simultaneously. If experience
suggests that the clean-up is not running efficiently, then upping the
number of threads here would be recommended. Conversely, if
production appears to be suffering courtesy of the clean-up process,
then reduce the number of threads here.
In general, higher end machines (those with multiple cores) will allow a
higher numbers of threads, whilst low end machines will perform better
with a lower number of threads.

l

Number of entities in each deletion batch: The number of entities to be
deleted at a time. This is done to break the clean-up into smaller chunks. This
improves PlanetPress Connect clean-up responsiveness, whilst the clean-up
is occurring.
The number selected here applies to all the following settings.
i.e. a selection of 1,000 would delete 1,000 data records within a Data Set,
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1,000 content items within a Content Set, and so on.
l

Minimum time to retain Data Sets: The minimum time a Data Set (and all the
records it contains) is retained within the database before being set for
deletion.

Tip
In order to prevent attempts at deleting database objects which might
still be in use, it is recommended that all Minimum time retention values
should always be set to at least the length of your longest job. Preferably
with some extra time added, for good measure.
For example, if your longest job takes 45 to 50 minutes to run, then set
the retention time to 55 minutes (or 1 hour) to ensure that all the
database objects created during job processing survive for the duration
of the job.

l

l

l

l

l

Minimum time to retain Content Sets: The minimum time a Content Set (and
all the content items it contains) is retained within the database before being
set for deletion.
Minimum time to retain Job Sets: The minimum time a Job Set (and all the
jobs information it contains) is retained within the database before being set
for deletion.
Minimum time to retain Managed Files: The minimum time file references (to
files such as data mapping configurations and templates) are retained within
the database before being set for deletion.
Minimum time to retain other entities: The minimum time any orphaned data
(such as Finishing tables, Media tables, DataModels and Properties tables)
are retained within the database before being set for deletion.

Database Partition Settings:
l

Use Database Partitioning: Select to use Database Partitioning.
l

Empty partition count: The number of empty partitions that are created each
clean-up run. This defaults to 24.
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l

l

Partition Size: Enter the length of time before partitions are switched. This can
be entered in minutes, hours, days, weeks or months.

File Clean-up Service:
l

Allow file clean-up service: Check to automatically detect orphan files and set
them for deletion. Orphan files could be resources and internal files used by
Connect, but which are not needed by any running job.
l

Minimum time to retain orphaned files: The minimum time during which
orphaned files are kept in the database before being set for deletion.

The Clean-up Services Preferences also provides you with buttons to :
l

l

l

Run Now: This will run the clean-up service immediately.
Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.
Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

------------------------------------------------------------------------------------------

Database Connection preferences
Dialog used to change the PlanetPress Connect back-end Database.
This dialog supports the swapping of the back-end database between various vendor
databases. Note, however, that the alternate vendor database(s) must already be installed and
available in order to swap to them.
This is not a migration tool. It is a simple connection tool, that enables shifting to a different
back-end database. Any existing data will not be transferred/ migrated between the databases,
and any existing File Stores will be cleansed by the Clean-up Service after the swap.
When shifting to a different back-end database, the changes won't be applied until PlanetPress
Connect is restarted. Including the Connect services. A full machine restart is recommended, as
this provides the cleanest restart of all the services.
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l

Basic Connection Settings selections:
l

Database vendor: Select the database type from the drop down list.

Note
Moving from one vendor database to another will reset all screen selections to
defaults, regardless of what may have been previously selected.

l

Database URL: This is a read-only summation of the current database connection
settings.

Tip
If the Test Connection button shows that the database cannot be
successfully connected to using the selected settings, then the contents of this
field could be used to try to connect to the database outside of PlanetPress
Connect. This should help in determining and refining the acceptable
connection options.

l

l

Hostname: Enter the IP Address or alias of the server where database resides.
Database Instance Name: Enter an existing Microsoft SQL Server's instance
name.
This option only applies to existing Microsoft SQL Server instances, and not for
MySQL.

l

Port: Enter Port number. The defaults are those which the vendors use by default.

l

Schema: The individual database schema, within the vendor database.

Note
If a previously non-existent schema were chosen here, then a new schema of
that name will be created within the database when the back-end database

Page 86

swap is applied. The tables within that schema, though, will not be created
until Connect is restarted.

l

Username: Enter the database login username.

Tip
It is considered best practice for this user to have root privileges.

l

l

Password: Enter the password associated with selected username.

Advanced Connection Settings selections:
l

Maximum concurrent threads: This option sets the maximum database threads.
The maximum setting is determined by the specific capabilities of the machine
Connect is installed upon (CPU speed and the amount of cores being the major
determinants).

Tip
Leaving this value set to the default maximum should be the best option in
most circumstances.
We recommended this entry be left at the default value.

l

Custom database parameters table: These are extra parameters which are
appended to the database connection URL. The default values are those which
have been determined to be useful in connecting to specific vendor databases.
l

Property: These are free field text fields.

Note
These fields and their associated values get appended to the JDBC
connection and therefore must follow all rules regarding acceptable
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URL addresses for such.

l

l

l

l

Value: The value applied to the associated Property.

l

Add: Used to add extra Property values to the table.

l

Delete: Used to remove existing Property values from the table.

Test Connection: Use to test if current connection settings will connect to the
specified database.
Restore Defaults: Will restore the settings to PlanetPress Connect
HyperSQL standard defaults.
Apply: When a database connection is confirmed as correct this button becomes
active, and is used to actually apply the database swap.

The Database Connection Preferences also provides you with buttons to :
l

l

l

Test Connection: This will run a test on the current Database Connection settings.
Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.
Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

------------------------------------------------------------------------------------------

DataMapper preferences
DataMapper XML Preferences
l

Display New Line Character as ¶ : Check to show line returns as ¶ in the Data Viewer,
when XML files are shown. If the option is unchecked, you will not see spaces and line
returns after element names in the Data Viewer.

DataMapper Default Format Settings
DataMapper stores user preferences for the Date, Number and Currency formats. By default,
the user preferences are set to the system preferences. These user preferences become the
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default format values for any newly created data mapping configuration.
Format settings can also be defined at the data mapping configuration level (Data mapping
configurations) and/or per field in the Data Model. Any format settings specified in an existing
field are always used, regardless of the user preferences or data source settings.
l

Negative Sign Before : A negative sign will be displayed before any negative value.

l

Decimal Separator : Set the decimal separator for a numerical value.

l

Thousand Separator : Set the thousand separator for a numerical value.

l

Currency Sign : Set the currency sign for a currency value.

l

Date Format : Set the date format for a date value.

l

l

Date Language : Set the date language for a date value (ex: If English is selected, the
term May will be identified as the month of May).
Treat empty as 0 : A numerical empty value is treated as a 0 value.

The DataMapper Preferences also provides you with buttons to :
l

l

Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.
Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

------------------------------------------------------------------------------------------

Editing preferences
These preferences define different editing options in the Designer module.
l

l

Object Resizing for <div> elements: This defines in which contexts to enable the
resizing of <div> elements (including Positioned and Inline boxes). Resizing <div>
elements may cause layouts to produce undesirable results especially when using
Foundation templates.
l

Enable for Print Context: Check to enable <div> resizing in the Print contexts.

l

Enable for Web Context: Check to enable <div> resizing in the Web contexts.

l

Enable for Email Context: Check to enable <div> resizing in the Email contexts.

Detail tables preview limit
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l

Maximum number of records to show in preview: This setting limits the number
of records to show in detail tables in both the Designer (Preview tab) and
Datamapper. The lower this number, the shorter the time before the preview or the
next record will appear.

CSS options
A CSS preprocessor is a CSS extension language that allows you to enhance CSS with code
(variables, for example) and then compile it into plain CSS. CSS Preprocessor Sass is
integrated in Connect.
For more information about Sass, see: Sass website.
The CSS options relate to the way Sass (.scss) files are compiled in Connect. See also: Using
a Sass file.
l

Output style: This setting determines the use of spaces and indentation in the compiled
CSS file. For examples of the available output styles, see: Sass reference: Output style.
l

l

l

l

l

Compact: Each CSS rule takes up only one line, with every property defined on
that line. Nested rules are placed next to each other with no new line, while
separate groups of rules have new lines between them.
Compressed: This output style minifies the output. It has no whitespace except that
necessary to separate selectors and a new line at the end of the file. It also includes
some other minor compressions, such as choosing the smallest representation for
colors. It's not meant to be human-readable.
Expanded: This is the default output style. Each property and rule take up one line.
Properties are indented within the rules, but the rules aren't indented in any special
way.
Nested: Each property has its own line, but the indentation isn't constant. Each rule
is indented based on how deeply an element is nested in the HTML and CSS
structure.

Auto compile on saving .scss files: When this option is checked, a .scss file is
compiled into a .css file whenever you save it, overwriting any previously compiled
version of the .css file. By default this option is enabled.

Color options
Many of the colors in the user interface of Connect Designer can be adjusted. Click the small
colored square next to the field that holds the default color value, to open the Color dialog and
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pick a color (see Color Picker).
l

Edges: The edges around elements in a section in the Workspace. Click the Show
Edges icon
l

l

l

l

l

l

l

l

Table: This color highlights tables, and the rows and columns in tables; see Table.
Resizable Table: This color highlights tables for which the option Allow resizing
has been checked when adding the table; see Table.
Forms: This color highlights forms; see Forms.
Shared Content: This color highlights shared content, such as shared snippets;
see Snippets.

Guides: This is the color for rulers that can help position content correctly; see
Guides.
Margins: This color delineates the content area on a page; see Page settings: size,
margins and bleed.
Bleed box: This color delineates the printable area on a page; see Page settings:
size, margins and bleed.

Master pages: These edges are only visible on Master pages; see Master Pages.
l

l

l

Box Objects: This color highlights positioned boxes, inline boxes and Div
elements; see Boxes.

Margin and guides: These settings only apply to Print sections.
l

l

to toggle the visibility of these edges.

Header and Footer Margin: This color highlights the header and footer margin set
for the Master page; see Adding a header and footer.
Objects: This color highlights all elements on the Master page.

Script Result Highlighter:
l

Results: Hovering over a script in the Scripts pane highlights content that will be
affected by the script; see Personalizing Content.

Images preferences
l

Transparent PDF image preview: Check this option so that PDF resources added to the
template (including in the Master Page and Media) display using transparency. Note that
this can affect display performance (showing transparent PDFs is slower) but will not
affect output speed.

The Editing Preferences also provides you with buttons to :
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l

l

Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.
Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

------------------------------------------------------------------------------------------

Email Preferences
Email (General) Preferences
l

Default From Group:
l

l

l

Name: Enter the name that is set by default in the "From name" field in the Send
Email and Send Test Email dialogs (Send (Test) Email).
Email Address: Enter the email that is set by default in the "From Email" field in the
Send Email and Send Test Email dialogs (Send (Test) Email).

Litmus account Group:
l

Email Test address: If you have a Litmus account, enter the test address to use
when sending a test email (see Send (Test) Email). For more information on Litmus,
please see http://litmus.com/.

Email (SMTP) Preferences
SMTP server presets can be selected when sending emails using either the Send Email or
Send Test Email dialog. (See Send (Test) Email and Email header settings). For all presets,
the password is not saved and must be re-entered when sending emails.
l

l

The Add, Edit and Delete buttons let you create and manage the presets.
SMTP Host Settings: These settings can be made or edited after clicking the Add or Edit
button.
l

l

l

l

Name: The name of the preset. This will show up in the Send Email dialog.
Host: The SMTP server through which the emails are to be sent. Can be a host
(mail.domain.com) or an IP address.
Port: The specified port number will be added to the host name, for example:
smtp.mandrillapp.com:465.
Use authentication: Check if a user name and password are needed to send
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emails through the host.
l

l

l

l

Start TLS: Enabled if authentication is checked. Sends emails through Transport
Layer Security (TLS), which is sometimes referred to as SSL.
User: Enter the user name used to connect to the SMTP server.

Restore Defaults: There are three default presets, each for working with a different Email
Service Provider (ESP): Mandrilapp.com, Sendgrid and Mailgun (see Using an ESP with
PlanetPress Connect).
Apply: Apply the new settings without closing the Preferences dialog.

The Email Preferences also provides you with buttons to :
l

l

Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.
Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

------------------------------------------------------------------------------------------

Emmet Preferences
Emmet is a framework that enables the lightning-fast creation of HTML code though the use of
a simple and effective shortcut language resembling CSS Selectors (see Emmet
Abbreviations). The Emmet functionality is available in the HTML and CSS source editors of
Connect Designer. Emmet transforms abbreviations for HTML elements and CSS properties to
the respective source code.
This is, for example, the abbreviation for a <div> element with the class row:
div.row
On pressing the Tab key, this abbreviation is transformed to:
<div class="row"></div>
To learn more about Emmet itself, please see their website Emmet.io and the Emmet.io
documentation. Emmet is a plugin. All options listed below are Emmet's default options. They
are not specifically adjusted for Connect.
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Common Emmet preferences
l

l

l

l

Expand abbreviations by Tab key: Check to enable the Expand Abbreviation function.
... in files with extension: Enter a comma-separated list of all file extensions in which
expand abbreviation will work.
Upgrade web editors: This Emmet option doesn't affect how Emmet works in Connect
Designer.
Extensions Path: Choose a folder where to put json and js files to extend Emmet. This
includes custom snippets, preferences and syntax profiles. For more information see
Customization.

Emmet Abbreviation Preferences
This Preferences tab lets you add and manage custom abbreviations. All standard
abbreviations can be found in Emmet's documentation: Abbreviations.
If there is no need to transform the text while expanding it, create an Emmet snippet instead
(see below).
l

New: Add a new abbreviation.
l

Name: The name of the abbreviation is also its trigger.

l

Context: The context in which the abbreviation is enabled (HTML, CSS, etc.).

l

Description: A short description of the abbreviation .

l

l

Pattern: This defines what an abbreviation expands to. Since Emmet is mostly used
for writing HTML/XML tags, abbreviation definition uses XML format to describe
elements; see Abbreviation types.
Automatically insert: This standard option doesn't affect how Emmet works in
Connect Designer.

l

Edit: Edit the currently selected abbreviation.

l

Remove: Remove the currently selected abbreviation.

l

l

l

Import: Click to open a browse dialog to import an XML file containing exported
abbreviations. The imported abbreviations are added to the current list.
Export: Click to open a Save as dialog to export all the abbreviations in an XML file that
can be shared and re-imported.
Preview box: Shows what the selected abbreviation is expanded to.
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l

l

Restore Defaults: clear all custom abbreviations.
To temporarily disable an abbreviation, uncheck the checkbox next to the name of the
abbreviation in the list.

Emmet Output Preferences
The Output Preferences dialog is used to control how the expanded (output) code behaves
when expanding abbreviations and snippets. There are 6 different dialogs to control output and,
while they all have identical options, they control different output types: CSS, HAML, HTML,
XML, XSL and the "Default" one controlling the rest of the types.
These options are equivalent to Emmet's syntaxProfiles.json feature.
Emmet Snippets Preferences
Emmet Snippet are similar to abbreviations in that they are expanded when the Tab key is
pressed, but they are just blocks of plain text. Anything in a snippet will be outputted “as is”,
without any transformation.
l

New: Click to create a new snippet.
l

Name: The name of the abbreviation is also its trigger.

l

Context: The context in which the snippet is enabled (HTML, CSS, etc.).

l

Description: A short description of the snippet.

l

Pattern: The pattern defines what a snippet expands to.

l

Automatically insert: This option doesn't affect how Emmet works in Connect
Designer.

l

Edit: Modify the currently selected snippet.

l

Remove: Remove the currently selected snippet from the list.

l

l

l

l

Import: Click to open a browse dialog to import an XML file containing exported snippets.
The imported snippets are added to the current list.
Export: Click to open a Save as dialog to export all the snippets in an XML file that can
be shared and re-imported.
Preview box: Shows what the selected snippet is expanded to.
To temporarily disable a snippet, uncheck the checkbox next to the name of the snippet in
the list.
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Emmet Variables Preferences
Variables are placeholders used in Emmet snippets to output predefined data. For example, the
html:5 snippet of HTML syntax has the following definition:
<!doctype html>\n<html lang="${lang}">...</body>\n</html>
In the example above, ${lang} is used to refer lang variable defined in variables below. If your
primary language is, for example, Russian, you can simply override lang variable with ru value
and keep the original snippets. Also, you can override variable values with inline abbreviation
attributes: html:5[lang=ru].
l

Name: The name of the variable. This should be a single alphanumeric string with no
spaces or special characters. For example, the myVar name is referred to as ${myVar}.

l

Value: The value of the variable when the snippet is expanded.

l

New: Click to create a new variable and define its name and value.

l

Edit: Click to modify the currently selected Variable.

l

Remove: Click to delete the currently selected Variable.

The Emmet Preferences also provides you with buttons to :
l

l

l

Reload Engine. This allows you to reload the Emmet engine based upon the current
settings.
Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.
Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

------------------------------------------------------------------------------------------

Engine Setup
See Engine Setup Peferences.
------------------------------------------------------------------------------------------
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Language Setting Preferences
l

l

Display language: Select a language from the drop-down list to be used as the language
of the User Interface (after the software is restarted).
Default Locale: The default locale sets the locale for new templates. By default this is the
system's locale. The locale can be changed per template; see Locale.
l

Select System Locale to use the operating system's locale settings.

l

Select Explicit Locale to choose a static locale from the drop-down list.

Default Locale
The Default Locale preferences are only available in the Designer Preferences. This setting
determines the locale for new templates. By default this is the system's locale. Select System
Locale to use the operating system's locale settings.Select Explicit Locale to choose a specific
locale from the drop-down Explicit Locale list.The Locale can be changed on a per template
basis. See Locale.
The Language Settings and Default Locale Preferences also provides you with buttons to :
l

l

Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.
Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

------------------------------------------------------------------------------------------

Log Setting Preferences
PlanetPress Connect logs the activities it undertakes whilst running. New Connect logs are
created daily and are held for a period before they are automatically deleted.
The settings on this page determine the level of logging and how long the log files should be
retained.
These log files can be an essential resource when diagnosing issues with OL Support. The
logging settings are global to all Connect applications and the Logging Preferences can be
adjusted from within any of the Designer and Server Configuration Preference dialogs.
The settings are:
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l

Overall Logging Level selection: Select the overall Connect Logging level. This controls
how much logging Connect will do.
By default the logging level is set at the midpoint of Info, but it can be set higher to include
more logging (All, Trace, Debug), or lower to reduce the amount of logging (Warning,
Error).
The logging is hierarchical, with each Logging Level selection containing all of the
Logging Levels below it. The default logging Info Level contains all Error and Warning
entries plus informational log entries.

Warning
Higher logging settings will have an impact upon Connect production speeds, as well as leading to
substantially larger log files.
We recommended leaving the logging level to Info and only using the higher levels of logging in
conjunction with advice from OL support.

l

Rollover policy selection: Chose whether to retain Connect log files for a certain number
of days (Daily logs) or based upon some predetermined hard disk usage limitations
(Size-based logs). The selection are as follows:
l

Daily Logs: Use this setting to determine how many days Connect Logs are to be
kept, before they are deleted.
l

l

Number of days to retain logs: This value only impacts upon historic
(closed) logs.
Chose between 1 and 99,999 days.
The default value is set to 10 days for a new installation and 99,999 days on
existing installations (to preserve backward compatibility).

Size-based logs: Use this setting to restrict log file size, and to keep only a
specified number of them.
By combining the maximize individual log file size with the amount of log files to
retain, this effectively allows a hard disk space usage limitation to be placed upon
the logging process.
l

Maximum size for log file: This sets the maximum size a log file can reach
before the logging system creates a new file.
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l

l

Number of files to keep:This sets the maximum number of log files kept in
the log folder. The default value is set to 50 for a new Connect installation and
99, 999 for an existing installation (to preserve backward compatibility).

Logging pattern edit box: This edit box determines the formatting of the individual log
entries.
By default it is set to a date/time value which allows for simple searching within log files.

Warning
We recommend leaving the Logging pattern to the default value.
If you do need to change the Logging pattern, please see the Pattern Formatting
guide for help in doing so.

l

Log message preview display: This displays a real time example of the format and
content of individual log file entries, based upon the Logging pattern setting.

Advanced Log Settings
The Advanced settings over-ride the Overall logging settings, and provide a greater level of
logging granularity.

Warning
Higher logging settings will have an impact upon Connect production speeds, as well as
leading to substantially larger log files.
The Advanced Log Settings should only be set in conjunction with advice from
OL support, to ensure that only the most relevant settings are set to the higher logging
levels.

This Preferences page allows you to add (

) or remove (

) individual Connect Packages, or

change their logging settings ( ).
The Log Setting and Advanced Log Setting Preferences also provides you with buttons to :
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l

l

Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.
Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

------------------------------------------------------------------------------------------

Print Preferences
Available Printers Preferences
The Available Printers preferences control which printer definitions are available when
generating print output or creating Output Presets. Any printer that is unchecked in this dialog
will not be visible in the "Model" drop-down of the Print Options dialog; see Print Options and
Adding print output models to the Print Wizard.
Available Printer Preferences:
l

l

Selected Printers: Lists the available Printer Definition Files in the system. Note that
these are not installed Windows printers or printer queues, but PlanetPress Connect
Printer Definition Files.
Printer checkbox: This checkbox selects/deselects all printers in the list. Click to check
all, click again to uncheck all.

General Print Preferences
The General Print Preferences are used to set communication settings with the PlanetPress
Connect Server module that does the actual generation of print output. The Server module can
be located on the same computer (hostname: localhost) or on a different machine. Multiple
Designer modules can use a single Server module to generate Print output, as long as the
appropriate hostname, username and password are provided. In essence, this can be used to
create a single Print Server.
l

Print Server Settings group:
l

l

Protocol: Use the drop-down to select whether to use the HTTP or the secure
HTTPS protocol to connect to the Print Server.
Hostname: Enter the IP, machine name or URL of the Print Server.
Default is localhost.
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l

l

l

l

Port: Enter the port through which to communicate with the Print Server.
Default is 9340.
Username: Enter the username to authenticate to the Print Server.
Default is ol-admin. This is set on the server's "Security Settings" on page 138.
Password: Enter the password to authenticate to the Print Server.
Default is secret.
Confirm Password: Re-enter the password above.

Print Measurements Preferences
l

l

Units: Use the drop-down to specify the default measurements system used for
dimensions of the template and boxes. In addition it defines the coordinates/position of
box elements.
The default unit will be added automatically when geometry values are entered without a
unit in the Attributes pane or in the Box Properties dialog.
Flip insert guide axis: Check this option to flip the axis on which guides are inserted.
Normally, dragging a guide from a horizontal ruler inserts a horizontal guide (see Guides).
With this option checked, dragging a guide from a horizontal ruler inserts a vertical guide.

The Print Preferences also provides you with buttons to :
l

l

l

Test Print Server URL. This button is only available for the General Print Preferences. It
tests the Print Server URL settings made within that Preferences page.
Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.
Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

------------------------------------------------------------------------------------------

Project Wizards
Project Wizard deployment settings
l

Workflow Configurations
l

Encoding: By default, Project Wizards set the encoding of the Workflow
configuration that they create to the encoding of the system on which the Designer

Page 101

runs (system default).
If Workflow runs on another machine, and that system has a different active code
page, Workflow may be unable to correctly interpret all the characters that are used
in the configuration file (in path or file names, for example). To prevent this, you may
select an encoding from the list.

Saving Preferences
The saving preferences are a way control if and how often PlanetPress Connect saves your
work in the background, and if how many backup files it creates when you save the template or
data mapping configuration. See also: Saving a template.
Auto Save
After a template or data mapping configuration has been saved for the first time, Connect
Designer can auto save it with a regular interval.
l

l

Enable: activate the Auto Save function.
Interval (minutes): enter a number of minutes, e.g. 3 to auto-save the template or data
mapping configuration every 3 minutes.

Auto Backup
Connect Designer can automatically create a backup file when you manually save a template
or data mapping configuration. The Auto Save function does not cause backup files to be
created.
l

l

l

Enable: activate the Auto Backup function.
Revisions to keep: Enter the maximum number of backup files. When the maximum is
reached, Auto Backup will overwrite the oldest file.
Destination: Select the directory in which the backups should be stored.
l

Original: the directory in which the original file is stored.

l

Other directory: use the Browse button to select another directory.

Backup files have the same name as the original file with two underscores and a progressive
number (without leading zeros) at the end: originalname__1.OL-template, originalname__
2.OL-template, etc.
The Save Preferences also provides you with buttons to :
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l

l

Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.
Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

------------------------------------------------------------------------------------------

Scheduling Preferences
The Designer's scheduling preferences are a way to control precisely how the PlanetPress
Connect Designer handles jobs when doing a Proof Print from the Designer. In all other cases
jobs are handled by the Connect Server, which will be using its own configuration settings; see
"Server Configuration Settings" on page 119.
For more information about scheduling preferences in PlanetPress Connect also see
Performance considerations.
Scheduling options
This preference page defines what is considered a small or large job (anything in between is
considered "medium" jobs). For a detailed description of all options, see "Scheduling
preferences" on page 131.
Scheduling - Merge engine
This preference page defines how different instances and speed units are attributed to different
jobs when creating output documents. For a detailed description of all options, see "Merge
engine scheduling" on page 132.
Scheduling - Weaver engine
This preference page determines the number of engines launched, as well as their speed,
when generating Print Output of any type. For a detailed description of all options, see "Weaver
engine scheduling" on page 135.
The Scheduling Preferences also provides you with buttons to :
l

Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.
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l

Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

------------------------------------------------------------------------------------------

Scripting Preferences
The Scripting preferences define different options related to scripting within PlanetPress
Connect. See also: Testing scripts.
l

General:
l

l

Script timeout at design time (sec): In Preview mode or when running the Script
Profiler (see the Profile Scripts dialog), a long running script is stopped after the
amount of time set here. The default is 2 seconds, the minimum is 1 second.
Expanded script quotes style: When the Expand button in a Script Wizard is
clicked, the expanded script will use either double (") or single (') quotation marks.

Tip
Using single quotation marks in a script simplifies adding HTML fragments,
which typically use double quotes.

l

Designer scripting profiling group:
l

Number of iterations: Enter the number of times to run scripts when running the
Profile Scripts dialog. The default is 1000. Accepted values are 1 to 1000000000.
Yes, that's 1 billion - which would take a long time to run!

The Scripting Preferences also provides you with buttons to :
l

l

Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.
Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

------------------------------------------------------------------------------------------
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Web Preferences
Web Form Preferences
These preferences define the default behavior of some form elements.
The preferences are as follows:
l

Insert Form Field Defaults:
l

Style: Defines how labels are added to input form elements:
l

l

l

l

l

Attach label to input: The label is placed before the input, and refers to it:
<label for="first_name">First Name</label> <input type="text" name="first_
name">
Use label as placeholder: The label is removed and the text is put as a
placeholder, such as: <input type="text" name="first_name" placeholder="First
Name">
No label: The label value is ignored.

Insertion Point: Defines how new elements are inserted, by default:
l

l

l

l

l

l

Wrap input with label: The label is wrapped around the element, such as
<label>First Name <input type="text" name="first_name"></label>

At cursor position: The element is inserted where the cursor is located in the
template.
Before element: The element is inserted before the current element where the
cursor is located. For example if the cursor is within a paragraph, insertion
occurs before the <p> tag.
After start tag: The element is inserted within the current element, at the
beginning, just after the start tag.
Before end tag: The element is inserted within the current element, at the
end, just before the end tag.
After element: The element is inserted after the current element where the
cursor is located. For example if the cursor is within a paragraph, insertion
occurs after the <p> tag.

Get Job Data File: Defines the Workflow URL to be used when the Get Job Data
File on submit toolbar button is active. This simplifies the process of creating and
testing COTG Forms (see Capture OnTheGo).
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l

Workflow URL: The default URL is: http://127.0.0.1:8080/_
getSampleFormData_

The Web Preferences also provides you with buttons to :
l

l

Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.
Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

------------------------------------------------------------------------------------------
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Known Issues
This page lists important information about issues that apply to PlanetPress Connect 2019.1.

The OL Connect 2019.1 license update
does not cater for existing AFP input
licenses
AFP Input is an add on option for OL Connect licenses. Unfortunately, the update to the 2019.1
version of the OL Connect license does not cater for existing AFP input licenses.
If you have an existing AFP input license we ask that you contact your local Customer Care
team after the initial license update is complete and have them add the AFP input option back
into your license.

Page break changes in 2019.1
Improved page breaking in Connect 2019.1 might impact upon some existing templates.
It is recommended that you check page breaking in existing jobs, where page breaks at a
specific location are a known criteria.

Issue after erroneous or incomplete update
or re-installation
If one or more products (the Connect Designer, Connect Server, Software Activation, Print
Manager, or Server Configuration Tool) or engines exit within a second of starting, this may be
caused by a recent erroneous or incomplete uninstall before a reinstall or upgrade to a newer
version of OL Connect. (See Product or engine exits within a second of starting in Connect's
Knowledge Base.)
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This may be solved by deleting the %UserProfile%\Connect\.eclipse directory.
For guidance on a full manual uninstallation please see the Solution in: Problems during a
Connect installation or version upgrade in Connect's Knowledge Base.

Backend database might require periodic
maintenance
Databases maintain a variety of statistics in order to optimize performance. When high levels of
inserts and/or deletions occur, the statistical data keeping can struggle to keep up. Over a
period of prolonged and intensive processing this can result in a degradation in performance,
with the whole database slowing down as it struggles to clean itself up.
In Connect terms the effect can be felt as the Data Mapper and/or Job Creation progressively
slowing down.
To cure this issue, it is recommended that you periodically run manual maintenance on the
backend database.
If using MS-SQL, you can run the following command in a query window:
set @a=null,@c=null,@b=concat("show tables where",ifnull(concat(" `Tables_in_
",database(),"` like '",@c,"' and"),'')," (@a:=concat_ws(',',@a,`Tables_in_
",database(),"`))");
Prepare `bd` from @b;
EXECUTE `bd`;
DEALLOCATE PREPARE `bd`;
set @a:=concat('optimize table ',@a);
PREPARE `sql` FROM @a;
EXECUTE `sql`;
DEALLOCATE PREPARE `sql`;
set @a=null,@b=null,@c=null;

If using MySQL, the following script should be run in a query window:
sp_updatestats
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Windows 10 Search service impacting
Connect
The Windows 10 Search service runs as a background task, indexing files and folders. It has
been noted that this background task is sometimes preventing files being added to the Connect
temporary files folder when large amounts of files are being output and copied.
If this is an issue for you, we suggest disabling Search Indexing on the
C:\Users\<username>\Connect folder.
This issue will be fixed in a later release.

Job Creation Presets: External Sorting
change introduced in 2018.2
Versions prior to 2018.2 did not correctly save the line end characters for external sort
configurations in Job Creation Presets, which meant the job could not be externally sorted. This
issue has been fixed in version 2018.2. However, Job Creation Presets created with an earlier
version may still have the wrong line end character for external sorting. To fix this, open the Job
Creation Preset in the new version, reset the line end setting in the sorting options and then
save the preset.

Engine Preferences: Backward
Compatibility Issues introduced in 2018.2
l

Prior to version 2018.2 Connect allowed a mixture of internal and external engines. As of
PlanetPress Connect 2018.2 this is no longer allowed.
When upgrading to PlanetPress Connect 2018.2 from such installations, the pre-existing
settings will not only no longer apply, but can cause scheduling preference conflicts for
the Merge and Weaver engines.
To fix this, any pre-existing Connect installation that was running a mixture of internal and
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external Merge and Weaver Engines must first restore their scheduling preferences to the
default values. This can be done by clicking on the Restore Defaults button in the
Scheduling pages of the Server Preference or the Designer Preference dialogs.
l

The Designer's scheduling settings are only updated correctly for the user actually
performing the update.

Business Graphics: Backward
Compatibility Issues introduced in 2018.1
As a consequence of changes in both the user interface and the underlying technology,
Business Graphics made with a version prior to PlanetPress Connect 2018.1 may not display
correctly when opened in version 2019.1.
The currently known backward compatibility issues are listed here:

All charts
l

l

l

Legend position: The position of the legend is not converted. It defaults to 'left' in a
converted chart.
Rows are series/Columns are series: Only one type of data structure for detail tables is
supported in the new version: the one that corresponds to the former Columns are series
setting (with which charts display one series per record, one bar/point per data field). After
conversion to 2018.1, charts that used the Rows are series setting will be displayed as if
the Columns are series setting were used. Pie charts will thus only show data from the
first record in the detail table. If the number of records in the detail table remains
consistent, then the charts can be corrected by modifying the data mapping configuration
(see Preparing a data table). Otherwise the data needs to be transposed via script.
NOTE: Expanded custom chart scripts cannot be converted.

Pie charts
l

Default colors: The default colors (used when no pie chart colors are specified) have
changed.
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Line and Bar charts
l

Legend label: In previous versions, the name for a values series (needed for the legend)
could only be taken from a field outside the detail table. The value of the selected field
would be used. Setting a different label required expanding the chart script. After
conversion, the name of the field is used instead of the value. Setting a different label can
now be done in the Edit Chart Script dialog (see Selecting data in a Business Graphic
script).

Known Font issues
The following font(s) are known to have issues in PlanetPress Connect 2019.1:
l

Benton Sans CFF font

Minor differences in PCL output
introduced in 2018.1
The browser component (Mozilla Gecko) used in the WYSIWYG editor of the Designer was
updated for Connect 2018.1. This allows use of new CSS properties, such as flexbox.
However this update could lead to increased output file sizes for some PCL jobs. This is
generally not a cause for concern, however there might be some associated increase in
processing times, as well as some minor differences in the output. For example, table line
widths and font spacings might differ slightly (particularly for SMALL CAPS text), which could
lead to slightly different word-wrapping in some circumstances.

Windows Server 2016 issue
As of PlanetPress Connect 2018.1 Connect is officially supported under Windows Server 2016.
Please note, however, that the Objectif Lune Inc. Update Client application might be blocked
by the enhanced security settings in Windows Server 2016.
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To fix this, add http://updates.ca.objectiflune.com to the list of trusted web sites on that machine,
or lower the internet access rules.

Limit of 100MB of image files within a
single job
The browser component (Mozilla Gecko) used in the WYSIWYG editor of the Designer was
updated for Connect 2018.1. This allows use of new CSS properties, such as flexbox.
However this update also introduced a limit of 100MBs for image files included within a single
job. The limit is set at 100MB deliberately, as this allows most jobs to run faster. However, if a
job requires more than 100MBs of image files, then the Connect image cache size can be
increased to cater for such.
Please contact OL Support for instructions on how to modify the image memory cache value, if
needed.

Print Output: Booklet Impositioning
changes introduced in 2018.1
When Booklet Impositioning is enabled, all pages within a document need to be changed to
duplex prior to Impositioning . The method for duplexing jobs has been changed to now always
combine existing pages into the front and backsides of sheets, rather than adding empty
backsides to any simplex pages.
The result is that now every document in the job becomes a booklet without any empty pages
between the first page and the last page.
With some exceptions. Booklet Impositionings that require a multiple of 4 pages (Saddle
binding and Perfect binding) will still get empty pages added, when needed.
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Issues with Microsoft Edge browser
The Microsoft Edge browser fails to display web pages when the Workflow's CORS option (in
the HTTP Server Input 2 section) is set to "*". This issue will be resolved in a future release.

Installation Paths with Multi-Byte
Characters
When installing the Chinese (Traditional or Simplified) or Japanese versions of Connect, if the
user specifies an alternative installation path containing multi-byte/wide-char characters it can
break some of the links to the Connect-related shortcuts in the Start Menu and cause an error to
appear at the end of the installer. The workaround for the moment is to use the default
installation path. The problem will be addressed in a later release.

Switching Languages
Changing the language using the Window > Preferences > Language Setting menu option
does not currently change all of the strings in the application to the selected language. This is a
known issue and will be fixed in a later release.
In the meantime we offer the following workaround for anyone who needs to change the
language:
1. Go to the .ini files for the Designer and Server Config:
l

C:\Program Files\Objectif Lune\OL Connect\Connect
Designer\Designer.ini

l

C:\Program Files\Objectif Lune\OL Connect\Connect Server
Configuration\ServerConfig.ini

2. Change the language parameter to the required one under Duser.language=en | es | de |
fr | it | ja | ko | pt | tw | zh
Only one of the above language tags should be selected. Once saved, Connect will appear in
the selected language at next start-up.

GoDaddy Certificates
When installing Connect offline, dialogs allow installing the GoDaddy certificates. Most users
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should use the default settings and click Next. In some cases, however, this may not work
correctly. For this reason those users should activate Place all certificates in the following
store and then select the Trusted Root Certification Authorities as the target certificate store.

MySQL Compatibility
After installing Connect 2019.1 a downgrade to a Connect version earlier than Connect 1.3 or
to a MySQL version earlier than 5.6.25 is not seamlessly possible. This is because the
database model used in Connect 1.3 and later (MySQL 5.6) is different to that used in earlier
versions. If you need to switch to an older version of Connect / MySQL, it is first necessary to
remove the Connect MySQL Database folder from "%ProgramData%\Connect\MySQL\data"
before installing the older version.
The minimum supported MySQL version is 5.1.31.

PostScript print presets
The print presets for PostScript were changed from Version 1.1 onwards meaning that some
presets created in Version 1.0 or 1.0.1 may no longer work.
Any PostScript print preset from Version 1.0 that contains the following will not work in Version
2019.1: *.all[0].*
Any preset containing this code will need to be recreated in Version 2019.1.

Available Printer Models
Note that only the single Printer Model (Generic PDF) will appear on the Advanced page of the
Print Wizard by default.
To add additional printer models click on the settings
entry box.

button next to the Model selection

Note that the descriptions of some of the printers were updated in version 1.2 meaning that if
you had version 1.n installed, you may find that the same printer style appears twice in the list,
but with slightly different descriptions.
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For example the following printer types are actually identical:
l

Generic PS LEVEL2 (DSC compliant)

l

Generic PS LEVEL2 (DSC)

External Resources in Connect
There are certain limitations on how external resources can be used in Connect. For example if
you want to link a file (e.g., CSS, image, JavaScript etc.) from a location on the network but you
do not want to have a copy of the file saved with the template you need to do the following:
1. The resource must be located where it can be accessed by all Servers/Slaves run as
users. Failure to do this will cause the image to appear as a Red X in the output for all
documents which were merged by engines which could not access the file. The job will
terminate normally and the error will be logged.
2. The file must be referenced via a UNC path e.g.,
file://///w2k8r2envan/z%20images/Picture/Supported/JPG/AB004763.jpg
l

l

UNC paths are required because the services will be unable to access mapped
network drives (Windows security feature).
The engine processing the job will look on the local file system for the direct file
path leading to the “resource not found” issue mentioned above.

Warning
Important Note: The Designer itself and Proof Print do not use processes that run as
services and they may find local files with non-UNC paths which can lead to the false
impression that the resources are correct.

Using Capture After Installing Workflow 8
If PlanetPress Connect Workflow 8 is installed alongside PlanetPress Suite Workflow 7,
Capture can no longer be used within Workflow 7. The plugins are now registered uniquely to
Workflow 8 and the Messenger for Workflow 7 is taken offline. It is only possible to use Capture
from PlanetPress Connect Workflow 8 thereafter.
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Capturing Spool Files After Installing
Workflow 8
If PlanetPress Connect Workflow 8 is installed alongside PlanetPress Suite Workflow 7, the
PlanetPress Suite 7 option to capture spool files from printer queues will no longer function.
The solution is to use PlanetPress Connect Workflow 8 to capture spool files from printer
queues.

Color Model in Style Sheets
The color model of colors defined in a style sheet can sometimes change after editing the style
sheet. This is a known issue and will be addressed in a subsequent release.

Image Preview in Designer
If in the Windows Internet settings (Connection Settings > LAN configuration) a proxy is
enabled, but "Bypass proxy settings for local addresses" is not checked, the image preview
service, conversion service and live preview tab in the Designer will not work and exhibit the
following issues:
l

Images will be shown as 0 size boxes (no red 'X' is displayed).

l

Live preview does not progress, and when re-activated reports "browsers is busy".

To fix the issue you must check the "Bypass proxy settings for local addresses" option.

Merge/Weaver Engines when Printing
The print operation in the Designer will automatically detect whether the Merge\Weaver
engines are available and display a message for the user to retry or cancel if not. Once the
Merge/Weaver engine becomes available and the user presses retry the print operation will
proceed as normal. This message can also occur in the following circumstances:
l

If the server is offline and you are not using Proof Print.

l

On some occasions before the Print Wizard opens.
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REST Calls for Remote Services
The Server will accept REST calls for all remote services and will make commands wait
indefinitely until the required engines become available. The Server will log when it is waiting
for an engine and when it becomes available. Note that there is no way to cancel any
commands other than stopping the Server.

Print Content and Email Content in
PlanetPress Workflow
In PlanetPress Workflow’s Print Content and Email Content tasks, the option to Update
Records from Metadata will only work for fields whose data type is set to String in the data
model. Fields of other types will not be updated in the database and no error will be raised.
This will be fixed in a later release.

Print Limitations when the Output Server is
located on a different machine
The following limitation may occur when using the Print options from a Designer located on a
different machine to the Output Server:
l

l
l

The file path for the prompt and directory output modes is evaluated on both the client
AND server side. When printing to a network share it must be available to BOTH the
Designer and Server for the job to terminate successfully.
The Windows printer must be installed on both the Server and Designer machines.
When printing via the Server from a remote Designer, the output file remains on the
Server machine. This is remedied by selecting “Output Local” in the Output Creation
configuration.

VIPP Output
Some templates set up with landscape orientation are being produced as portrait in VIPP. It can
also sometimes be the case that text and images can be slightly displaced. These are known
issues and will be addressed in a later release of Connect.
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Magic Number changes when installing
Docker
Installing Docker on a system where Connect has already been installed may impact Connect's
licensing mechanism and require reactivation.

Note
Installing Connect after Docker has already been installed will not cause issues.
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Server Configuration Settings
This chapter describes configuring the PlanetPress Connect Server.

The Connect Server settings are maintained by the Connect Server Configuration utility tool
which is installed alongside PlanetPress Connect.
Connect Server Configuration can be launched from the Start Menu, as seen in the following
screenshot:

The Connect Server Configuration dialog is separated into individual pages, where each
page controls certain aspects of the software.
The following pages are available:
l

"Clean-up Service preferences" on page 81 preferences

l

Connection preferences
l

"Security Settings" on page 138

l

"Database Connection preferences" on page 85 preferences

l

Engine Setup preferences
l

Automatic Restart preferences

l

"Language Setting Preferences" on page 97 preferences

l

Logging Settings preferences
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l

"Scheduling preferences" on page 131
l

"Merge engine scheduling" on page 132

l

"Weaver engine scheduling" on page 135

Connection preferences
Background
The Connection preferences are a way to control precisely how to connect to the PlanetPress
Connect Connect Server.
This preference page was added in Connect 2018.2 to simplify management of
HTTP communication with Connect.
It allows Connect inter-engine communication to occur on an alternate port, reducing the
chances of inter-engine communication being starved of connections when running on a
system that processes very large numbers of HTTP connections.

Connection settings
l

Primary Connection group. Use this to adjust the HTTP communication settings for
Connect.
l

l

l

l

Port: Set the primary HTTP Server connection port number for Connect.
Maximum threads: Sets the maximum number of HTTP threads for processing
requests.
This entry should only be changed in consultation with OL.
Maximum queues: Sets the maximum number of requests can remain in the queue.
This entry should only be changed in consultation with OL.
Maximum asynchronous jobs: Set the maximum number of requests that can be
executed simultaneously.

Note
This does not limit the number of requests that can be received, just how
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many are processed in parallel. Additional requests are buffered and are
processed as capabilities allow.

The default setting is twice the number of processing cores available to the
computer. This can be expanded, if the limitation is deemed a bottleneck.
l

Dedicated Internal Connection checkbox:
Set the internal connection HTTP communication setting values. These settings are
purely for Connect inter-engine communication.
If used, local security settings (including firewalls) must be taken into consideration.
l

l

l

Port: Set the Server connection port number. This cannot be the same at the
Primary connection port number.
Maximum threads: Sets the maximum number of HTTP threads for processing
requests.
This entry should only be changed in consultation with OL.
Maximum queues: Sets the maximum number of requests can remain in the queue.
This entry should only be changed in consultation with OL.

Engine configuration
The Connect Server cooperates with different engines to handle specific tasks. A DataMapper
engine extracts data from a data file. A Merge engine merges the template and the data to
create Email and Weboutput, or to create an intermediary file for Printed output. The
intermediary file is in turn used by a Weaver engine to prepare the Print output. (For more
information see: Connect: a peek under the hood).
Settings for these engines are made in the Connect Server Configuration tool (see "Server
Configuration Settings" on page 119). These 'Scheduling Preferences' allow you to control
precisely how the PlanetPress Connect Connect Server handles jobs.
Connect allows for the parallelization of jobs. This means you can allocate 1 or more engines
to process jobs. The number of each type of engine is configurable, as well as the amount of
Merge engines than can work together on the same job (determined by job size: small, medium
or large) and at what maximum speed.
This gives you, as solution developer or application manager, full control of how to apply a
machines power. For example, you can share the available resources to process multiple jobs
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at once or allocate all resources to process one job as fast as possible, or anything in between.
Connect distinguishes 5 type of jobs:
1. Small Print
2. Medium Print
3. Large Print
4. Email
5. Web
Connect categorizes incoming print jobs on the number of records inside it. The boundaries
between a Small to Medium job and Medium to Large job can be configured per server (see
below, "Allocating processing power to jobs" on page 126).
There is no distinction between small, medium and large jobs for Email and Web output.
This topic explains all of these settings and the principles behind them, and it provides
guidelines for letting the Server manage the workload in such a way as to achieve the highest
possible output speeds.
Factors to take into account are:
l

l

l

Your licence, which imposes a speed quota (see "Speed quota: PPM and speed units"
on the next page).
The processing power of your machine. How many cores it has determines how many
engines can be launched (see "Launching multiple engines" on page 124).
The size and number of jobs of one kind that need to be handled, sequentially or
simultaneously. In other words, your use case. By allocating processing power to jobs of
different sizes you can make the setup match your usage situation (see "Allocating
processing power to jobs" on page 126).

Tip
Other ways to enhance performance are described in another topic: "Performance
considerations" on page 20.
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Speed quota: PPM and speed units
The highest possible output speed depends first and foremost upon your licence.
With no Performance Pack, in PlanetPress Connect, one engine can generate output at 500
PPM (Pages and emails and web pages - Per Minute). Additional Performance Packs increase
this quota.
The number of engines that are allowed to operate in parallel to create the same type of output
are referred to as speed units.
PlanetPress Connect provides 6 speed units. Additional Performance Packs will increase this
number.
So, with no Performance Pack, up to 6 engines can create the same type of output in parallel,
which means the total maximum output speed is 3,000 PPM per output type (Print, Email, and
Web).
One engine needs at least one free speed unit to be able to create output.
It is important to note that only output operations are limited by this quota.
l

l

l

Weaver engines always require a speed unit to run.
Merge engines only require a speed unit when creating Email or Web output. Merge
engines involved in a Print process don't need a speed unit in order to run.
DataMapper engines don't need speed units.

In situations where Print and Email and/or Web output are created at the same time, only the
Merge engines that create Email/Web output count towards the maximum number of speed
units for that type of output.
Spare speed units are distributed proportionally
Since the number of engines is configurable, and jobs may run concurrently, the number of
engines in use may not match the exact number of available speed units.
When there are more speed units than there are engines in use, the Connect server distributes
the speed units and the maximum 'pages' per minute to all running jobs in proportion to the
number of engines they are using.
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Note
Output speed is the speed at which the output is created by the engine in question. Data
mapping and other steps in a production process are not taken into account. The
throughput speed is the speed of the entire production process. This will always be
lower than the output speed.

Launching multiple engines
One single engine can only process a single job at a time and will run mostly single-threaded.
In order to benefit from multi-core systems it is recommended that several engines run in
parallel.
As a rule of thumb, you will want to run one less engine in total on a machine than the system
has cores, leaving one CPU core for the Connect Server and the operating system to use.
Modern hardware typically has both full cores and hyper-threading or logical cores. The
logical cores should not be counted as a full core when determining how many engines to use.
As a guide, count logical cores for only 25%-50% of a full core.
For example: on an Intel i7 CPU that comes with 4 cores and 4 additional hyper-threading
cores, Windows Task Manager will show 4 cores and 8 logical processors on its performance
tab. On a CPU like this, 5 or 6 engines can be configured to run in parallel.
To configure the number of engines:
1. Select Window > Preferences... from the menu.
2. Under Scheduling, select a type of engine.
3. Set Local engines launched to a number appropriate for your system. See "Deciding
how many engines of each type to launch" below.
4. Click OK or Apply.
It is advised that you do not configure more engines than can be backed by actual processing
power. This adds overhead while not adding processing power.
Deciding how many engines of each type to launch
When jobs run in parallel, different types of engines may run at the same time. It depends on
the usage situation which type of engines has the biggest impact on performance.
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The more and the larger operations of a kind need to be performed simultaneously with smaller
operations, the sooner you will see a performance increase when using multiple engines.
Merge engine
Generally, launching a relatively high number of Merge engines results in better performance,
as Merge engines are involved in the creation of output of all kinds (Print, Email and Web) and
because content creation is relatively time-consuming.
DataMapper engine
Adding DataMapper engines might be useful in the following circumstances:
When large data mapping operations have to be run simultaneously for many jobs When
frequently using PDF or XML based input. Particularly in the case of XML input with large
individual records. When the All-In-One plugin is used often in Workflow configurations and
there are more than two Merge engines running. The Connect MySQL database needs a fast
storage system (SSD or other fast devices) to be able to keep up with two or more DataMapper
engines. When the database is installed on a system with a slow hard drive, adding a
DataMapper engine may not increase the overall performance.
Weaver engine
Adding extra Weaver (Output) engine(s) might be useful when large Print jobs are to be run
simultaneously with smaller Print jobs.
Memory per engine
By default, each engine is set to use up to a predetermined amount of RAM. To make optimum
use of a machine's capabilities it might be useful to increase the amount of memory that the
various engines can use.
l

l

l

DataMapper engines may perform better with greater memory when running jobs
containing a lot of data.
For complex templates with a lot of pages per document, there is a chance that Merge
engines will run better with more memory.
The maximum memory usage of a Weaver engine can be relevant for jobs with heavy
graphics; or for jobs that use Cut & Stack impositioning; or for jobs using particular
variables that entail page buffering (see Content variables).

The Maximum memory per engine setting is found in the Engine Setup preferences.
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These setting only control the maximum size of the Java heap memory that an engine can use;
the total amount of memory that will used by an engine is actually a bit higher.
Also keep in mind that the Connect Server and the operating system itself will need memory to
keep running.

Allocating processing power to jobs
Which engine configuration is most efficient in your case depends on how Connect is used.
What kind of output is needed: Print, Email, and/or Web? How often? How big are those jobs?
Do they have to be handled at the same time or in sequence? Would it be useful to give priority
to small, medium or large jobs, and/or to jobs of a certain kind?
Depending on the answers to these questions, you can allocate processing power to jobs in
order to run them as fast as possible, and/or in the order of your preference.
The first step in this process is to define the size of small, medium and large jobs.
Job size
Connect lets you define job sizes by setting the maximum number of records in a small job,
and the minimum number of records in a large job. Jobs that are neither small nor large are
medium sized. (Note that the term 'records' refers to top-level records only. Detail records are
not considered.)
Determining the size of small, medium and large jobs is important because you can assign
more resources to medium and large jobs via the settings for Merge and Weaver engines.
There is no recommendation to make for the number of records in a small, medium or large job.
This setting needs to be based on an assessment of the actual (or expected) workload of
Connect. Job size is a relative concept: in a small service company a job may be considered
large when it counts 1,000 records, whereas in a large insurance company the same job may
be seen as small. Also take into account that jobs with fewer records could actually be medium
or large if each individual record outputs 10,000 pages.
To set the job sizes:
1. Select Window > Preferences... from the menu.
2. Under Scheduling, enter the maximum number of records in a small job. Note that small
jobs always get just one engine, so they should be easily handled by one engine.
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3. Enter the minimum number of records in a large job. The number of engines used for
medium and large jobs is configurable (see below).
4. Click OK or Apply.
Running a job as fast as possible
Number of parallel engines per Print job
Two or more engines of a kind can be combined to work on the same Print job. Generally jobs
will run faster with more than one engine, because sharing the workload saves time.
However, running one job with multiple engines reduces the number of jobs that can be
handled at the same time by that kind of engine, because there are only so many engines (and
speed units) available.
To select a number of parallel engines per Print job size:
1. Select Window > Preferences... from the menu.
2. Under Scheduling, select Merge Engine.
3. Set the Parallel engines per job for medium and large Print jobs; small jobs always get
one engine. You cannot assign more engines than the total number of engines launched.
4. Click OK or Apply.

Note
When each individual record in a job is composed of a very large number of pages, the
Memory per engine setting and the machine's hard drive speed are probably more
important than the number of Merge engines, since one record cannot be split over
multiple cores (see "Memory per engine" on page 125).

Number of speed units per Print job
If a Print job of a specific size has more than one parallel speed unit assigned to it, that
multiplies its speed, however it reduces the number of Print jobs that can be run
simultaneously.
When no other Print output operations run at the same time, a single job will get all available
speed units, or the maximum number of speed units reserved for jobs of that size (see "Dividing
processing power over jobs" on the facing page).
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To set a number of speed units per Print job:
1. Select Window > Preferences... from the menu.
2. Under Scheduling, select Weaver Engine.
3. Set the Parallel speed units per job for medium and large Print jobs. Small jobs get one
speed unit. You cannot assign more speed units than what you have available according
to your licence.

Note
Keep in mind that when there aren't enough speed units available at the moment a
job comes in, the job will have to wait.

4. Click OK or Apply.
Number of speed units for Email and Web
Although assigning parallel speed units to Email and HTML jobs is possible (on the Merge
Engine settings page), it is advised to use only one speed unit per job, firstly because these
jobs are usually small.
Secondly, HTML jobs need to be handled as soon as possible, particularly if a request was
made over the internet; you don't want those jobs to be kept waiting until the required number of
speed units becomes available.
Email output doesn't benefit much from speed units, because most time is spent on
communicating with an external SMTP server.
Dividing processing power over jobs
There is a number of ways in which you can divide processing power over output operations of
a certain kind and/or size.
l

By reserving Merge engines for jobs of a certain kind (and size, in the case of a Print
job). Note that reserved engines cannot be used by any other type of job. This means
there will be fewer engines to handle other jobs. Consequently, the other jobs may take
more time and may have to wait (or wait longer). However, if the server receives many
web requests then having engines reserved for HTML output can help performance.
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l

l

l

l

By setting the maximum number of Merge engines that can handle jobs of a certain
kind, or (in case of Print jobs) size, concurrently. This setting is useful to ensure that
there will always be some Merge engines available for jobs of another size or kind.
By requiring a number of parallel engines for Print jobs of a certain size (see "Number of
parallel engines per Print job" on page 127). More parallel engines will make them run
faster, but they will have to wait (longer) if the required number of engines - and speed
units - isn't available when they come in.
By reserving speed units for Print jobs of a certain size.
By setting the maximum number of speed units to use for Print jobs of a certain size.
This setting is useful to ensure that there will always be some speed units available for
other Print jobs. It also limits the number of Print jobs of that size that can run concurrently:
if, for example, large Print jobs require 4 parallel engines, and the maximum number of
speed units for large Print jobs is also 4, only one large Print job can run at a time.

All of these engine configuration settings are found in the Scheduling Preferences:
1. Select Window > Preferences... from the menu.
2. Under Scheduling, select Merge Engine, or Weaver Engine.
How the Server decides if a job can be handled
In summary, this is how jobs are handled when they can run in parallel.
l

l

l

l

Whenever a job comes in, the number of engines to use is determined. (For Print jobs,
this is based on whether the operation is small, medium or large; see "Job size" on
page 126.)
If there are enough reserved Merge engines for that type of job available then those
engines will be used.
If there are not enough reserved Merge engines available, then any unreserved Merge
engine that is available will be used.
If no, or not enough, Merge engines are available then the job will have to wait until the
required number of appropriate Merge engines becomes available.

The following limitations apply at all times:
l

l

The maximum number of concurrent Merge engines working on jobs of the same kind or
size may not be exceeded.
If no - or not enough - speed units are available for that type of output, the job must wait.
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Examples
Here are a few examples of use cases and settings that would be appropriate in such cases.
Batch processing. In a batch processing situation, jobs don't have to be handled
simultaneously. All jobs - whether they are big and small - are processed one after another.
Every job should be handled as quickly as possible. It is therefor recommended to assign the
maximum number of engines and speed units to all jobs. Do not reserve engines or speed units
for certain jobs.
Web requests. In online communication, response times are critical. If the Server receives a lot
of Web requests, it should handle as many as possible, as quickly as possible, at the same
time. It is recommended to launch as many Merge engines as possible and to reserve most of
them for HTML output. The jobs will generally be small and can do with just one Merge engine.
Mixed jobs that are processed in parallel. In a situation where small, medium and large jobs
can come in at any time and should be handled in parallel, the challenge is to find a balance
between how much power can be allocated to jobs (to minimize the time they cost) and how
long they can wait. No single job should require all of the processing power, unless it is
acceptable for it to have to wait until the maximum number of engines finally comes available and then all other jobs will have to wait.

Automatic Restart Settings
It is considered good management to restart the Connect Engines periodically. This dialog
provides the controls for scheduling Connect Engines restarts.
l

l

l

l

Time Limit checkbox: This enables engine restarts to be scheduled to occur either after a
specified period of time, or within a daily time window.
This means daily Engine restarts can be scheduled to run outside of production hours.
Rolling restart checkbox: This sets the engines restarts to occur in a "rolling" fashion,
whereby each engine is stopped and restarted individually, one after the other.
Each engine is only stopped when the previously restarted engine is once again ready to
start processing.
Restart method: Chose between restarting after a specified number of minutes (Restart
after interval) or within a daily time window (Daily restart in period).
Restart after (minutes): Only available if Restart after interval selected.
Specify the amount of minutes that the restarts are to occur after.
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l

l

l

Daily restart period begin: Only available if Daily restart in period selected.
Enter the daily start time for the time window in which automatic restarts will be scheduled
to occur.
Daily restart period end: Only available if Daily restart in period selected.
The end of the daily time window in which the automatic restarts are scheduled to occur.
Memory limit group: Enter the memory limit for individual Engines. If any of the memory
limits are exceeded, an automatic restart of those Engines will be triggered.
l

Data Mapper Engine (MB): Enter the memory limit for Data Mapper Engine.

l

Merge Engine (MB): Enter the memory limit for Merge Engine.

l

Weaver Engine (MB): Enter the memory limit for Weaver (Output) Engine.

Scheduling preferences
The scheduling preferences are a way to control precisely how the PlanetPress Connect
Connect Server handles jobs.
For more information on how these preferences can enhance performance, see "Engine
configuration" on page 121 and "Performance considerations" on page 20.

Scheduling properties
l

Configure Scheduling options: These two settings allow you to define what type of job
is to be considered a Small job and what type is to be considered a Large job. Any job
that falls between these two settings will be considered a Medium job.
l

Maximum records in a small job: Enter the maximum number of records for a job
to be considered Small.
Do not set the limit for small jobs too high; it isn't possible to attribute more than one
engine to small jobs, so they should always be easy to handle for one engine.

l

Minimum records in a large job: Enter the minimum number of records required
before a job can be considered a Large job.
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Note
Changes made to these settings will be applied on the run. Existing jobs will
be taken into account when determining if a job can run.
For instance, if the minimum records for a Large job is increased from 1,000 to
10,000 and a job of 2,000 records is already running, then this existing job will
now be considered a Medium job.
Likewise, if the minimum records for a Large job is decreased from 10,000 to
5,000 and a job of 7,000 records is already running, then this existing job will
now be considered a Large job.

All Server scheduling is actually handled in the Master Server.
Scheduling preferences per engine

Scheduling preferences can be applied to the distinct engines used in the Connect production
process. A DataMapper engine extracts data from a data file. A Merge engine merges the
template and the data to create Email and Weboutput, or to create an intermediary file for
Printed output. The intermediary file is in turn used by a Weaver engine to prepare the Print
output.
Each of these engines has its own Scheduling Preferences page. These are as follows:
l

"Merge engine scheduling" below

l

"Weaver engine scheduling" on page 135

Merge engine scheduling
A DataMapper engine extracts data from a data file. A Merge engine merges the template and
the data to create Email and Weboutput, or to create an intermediary file for Printed output. The
intermediary file is in turn used by a Weaver engine to prepare the Print output.
This preferences page defines how many Merge engines are launched and how speed units
are allocated to different jobs when creating production output. By default the number of Merge
engines is set to two.
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You can confirm how many Merge engines are running by checking Task Manager and
locating the mergeengine.exe entries in your process list.
Note: there will be an extra Merge and Weaver engine in your task manager if you run
Designer.
The Merge engine is responsible for the plugins Create Print Content, Create Email Content
and Create Web Content.
License restrictions only apply to the Merge engine when creating Email or Web content. They
do not apply for Create Print Content. This means you are allowed to start an infinite amount of
Merge engines on any given Connect Sever to run print jobs, but you will be restricted to a set
number of Merge engines for your Email and HTML jobs.
For an explanation of the various engines, the terminology and their settings, see "Engine
configuration" on page 121.
For some performance tips, see "Performance considerations" on page 20.

Note
Changes made to the following settings will be applied on the run (when the Apply button is
pressed), and do not require the OLConnect_Server service to be restarted.

l

Engine information
l

Total engines available: Read-only box indicating the current number of engines
that are available.
On the main Server of a PReS Connect cluster, this would also include all engines
in the cluster (Server Extensions).
The amount of engines available on this machine is set in the Engine Setup
Preferences page.

l

l

Local engines launched: Read-only box displaying the current number of engines
that have been launched on this machine.
The amount of engines available on this machine is set in the Engine Setup
Preferences page.
Expected remote engines: Only available for editing on PReS Connect Server
when Clustering is active (as determined by Connect license).
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l

l

Parallel engines per job: This area determines how many Merge engines are used for
each print job of a particular size. Small print jobs always get just one engine.
l

l

l

Limit in license: Read-only box indicating the maximum number of speed units
useable for producing output.Reserved Count: Read-only box indicating the total
number of "Reserved" engines, as set in the Engine reservations group below.

Parallel engines per medium print job: Enter the number of engines that will cooperate on a medium print job.
Parallel engines per large print job: Enter the number of engines that will cooperate on a large print job.

Parallel speed units per job group: This area determines - in the case of Email or Web
content - how many speed units are used for each kind of job (for an explanation, see
"Speed quota: PPM and speed units" on page 123). If jobs of a certain kind have more
than one parallel speed unit assigned to them, that many engines will be used to run each
of those jobs.
If the Server receives a lot of Web requests, it is advisable to reserve a large number of
Merge engines for HTML, to minimize response times. For Email output, 1 Merge engine
is sufficient.
l

l

Parallel speed units per email job: Enter the number of speed units to use when
handling an Email job.
Parallel speed units per HTML job: Enter the number of speed units to use when
handling a Web HTML job.

Note
Email and Web output are generated with the Merge engine only and thus their
output speed is limited through this engine.
Print jobs, however, are limited through the Weaver engine, so when a Merge
engine creates Print content it doesn't need to consider any Merge engine speed
unit settings. It can run without limitation.

l

Engine reservations group: This area is used to reserve engines specifically for certain
types of jobs. Reserved engines cannot be used by any other type of job.
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l

l

l

l

l

Floating: Read-only box indicating the number of floating engines that can be used
for any type of job. This number is equal to the Total Engines Available minus any
Reservations.
For example if 6 Merge engines are available and 4 are reserved for small jobs,
then 2 will be Floating.
Small print job speed unit reservations: Enter the number of engines to be
reserved for Small print jobs.
Medium print job speed unit reservations: Enter the number of engines to be
reserved for Medium print jobs.
Large print job speed unit reservations: Enter the number of engines to be
reserved for Large print jobs.

l

Email engine reservations: Enter a number of engines reserved for Email jobs.

l

HTML engine reservations: Enter a number of engines reserved for Web jobs.

Maximum concurrent engine per type: This area defines the maximum possible
number of engines used for any specific job type. The limit needs to be at least the
number of reserved engines or parallel speed units, whichever is lowest.
l

l

l

l

l

l

l

Small print job limit: Enter the maximum number of engines that can run small print
jobs.
Medium print job limit: Enter the maximum number of engines that can run medium
print jobs.
Large print job limit: Enter the maximum number of engines that can run large print
jobs.
Email limit: Enter the maximum number of engines that can run Email jobs.
Maximum Email limit in license: Read-only box indicating the maximum number of
engines useable for Email content creation.
HTML limit: Enter the maximum number of engines that can run Web jobs.
Maximum HTML limit in license: Read-only box indicating the maximum number of
engines useable for Web content creation.

Weaver engine scheduling
A DataMapper engine extracts data from a data file. A Merge engine merges the template and
the data to create Email and Weboutput, or to create an intermediary file for Printed output. The
intermediary file is in turn used by a Weaver engine to prepare the Print output.
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This preference page determines the number of Weaver engines launched, as well as their
speed, when generating the output.
The Weaver Engine is used to convert one specific job into the Print output of your choice. A
single Weaver engine can only ever convert one specific job to whatever output you want.
When you want to create output for multiple jobs in parallel, you will need to increase the
number of Weaver engines.
Too many engines will waste precious RAM and CPU cycles to idle processes, whilst too few
could create a bottleneck.
Each Weaver engine requires a speed unit from the available speed unit reservation pool. If no
speed unit is available, the job will be queued even if an engine is available.
For an explanation of the various engines, the terminology and their settings, see "Engine
configuration" on page 121.
For some performance tips, see "Performance considerations" on page 20.

Note
Changes made to the following settings will be applied on the run (when the Apply button
is pressed), and do not require the OLConnect_Server service to be restarted.

l

Engine information:
l

l

l

Total engines available: Read-only box indicating the current number of engines
that are available.
On the main Server of a PReS Connect cluster, this would also include all engines
in the cluster (Server Extensions).
Local engines launched: Read-only box displaying the current number of engines
that have been launched on this machine.
It is recommended that you increase the number of Weaver engines to at least 2
engines when using the PCL, PS or AFP inputs within the DataMapper.
The amount of engines available on this machine is set in the Engine Setup
Preferences page.
Expected remote engines: Only available for editing on PReS Connect Server
when Clustering is active (as determined by Connect license).
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l

l

l

l

l

Reserved Count: Read-only box indicating the total number of "Reserved"
engines, as set in theSpeed unit reservations topic below.

Parallel speed units per medium job: Enter the number of speed units to use
when handling a medium print job.
Parallel speed units per large job: Enter the number of speed units to use when
handling a large print job.

Parallel engines per job: These settings determine how many Weaver engines are used
depending on the size of a job set. A job set is the result of a Job Creation Preset that has
Job Grouping (see Job Creation Presets and Grouping Options). Individual jobs always
get just one engine.
l

l

l

Limit in license: Read-only box indicating the maximum number of speed units
useable for producing output.

Parallel speed units per job: If a specific type of job has more than one parallel speed
unit assigned to it, that multiplies its speed, however it reduces the number of jobs that
can be run simultaneously, since each engine needs at least one speed unit in order to
run (see "Speed quota: PPM and speed units" on page 123).
When you do run 2 or more Weaver engines, parallel output creation is only possible if
each engine has access to speed units. Therefore you will need to divide the available
parallel speed units between medium and large print jobs.
If a large job is using all speed units to produce output, then any other print job will be
queued until the large job is processed, even if a Weaver engine is available.
l

l

Speed units launched: Read-only box indicating the number of speed units
launched.

Parallel engines per medium print job: Enter the number of engines that will cooperate on a medium sized job set.
Parallel engines per large print job: Enter the number of engines that will cooperate on a large job set.

Speed unit reservations:
l

l

l

Floating: Edit box for selecting the number of floating speed units that can be used
for any type of job
Small job speed unit reservations: Enter a number of speed units reserved for
small print jobs.
Medium job speed unit reservations: Enter a number of speed units reserved for
medium print jobs.
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l

l

Large job speed unit reservations: Enter a number of speed units reserved for
large print jobs.

Maximum speed units:
l

l

l

Small job limit: Enter the maximum number of speed units that can run small print
jobs.
Medium job limit: Enter the maximum number of speed units that can run medium
print jobs.
Large job limit: Enter the maximum number of speed units that can run large print
jobs.

Security Settings
This dialog controls the security settings for external applications connecting to the PlanetPress
Connect Server, such as PlanetPress Workflow or scripts communicating through the REST
API.

Warning
It is highly recommended to keep security enabled and change the password on any server that
accessible from the web. If these precautions are not taken, data saved in the server may be
accessible from the outside!

l

l

l

Enable server security: Enable to add authentication to the REST server.
- When enabled, the same username and password (which cannot be blank) must be
entered in any remote Connect Designer that links to this Server. The Designer username
and password entries can be found under the "Print Preferences" on page 100 subsection of the Designer Preferences dialog.
- When disabled, a username and password is not required to make REST request, and
tasks in PlanetPress Workflow do not require them in the Proxy tab. Nor would a
username and password be required on any remote Connect Designer that links to this
Server.
Administrator's username: Enter the username for the server security. The default
username is ol-admin.
Administrator's password: Enter a password for the server security. The default
password is secret.
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l

l

Confirm password: Re-enter the password for the server security.
Default session length (min): Enter a session time (in minutes) that the authentication
stays valid for the requested process. This can reduce the number of requests to the
server since an authentication request is not necessary during the session.
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Uninstalling
This topic provides some important information about uninstalling (removing) PlanetPress
Connect2019.1.
To uninstall PlanetPress Connect select the application from within the Add/Remove programs
option under the Control Panel. This will start the PlanetPress Connect Setup Wizard in
uninstall mode.

Note
The PlanetPress Connect Setup Wizard might take some seconds to appear.

Important Note: Stop any active Anti-Virus
software before uninstalling Connect.
Some anti-virus systems are known to block the uninstallation of MySQL datafiles, as well as
blocking the uninstallation of the MySQL database application itself. Therefore it is highly
recommended that any anti-virus application be stopped prior to uninstalling PlanetPress
Connect, as otherwise the Connect uninstallation might not work correctly.

Impacts upon other Applications and
Services
l
l

The Uninstall will terminate the installed Server / MySQL service(s).
The following applications / services should be stopped in a controlled fashion, before
running the PlanetPress Connect Uninstall:
1. PlanetPress Connect
2. Connect products on remote systems which refer to this MySQL database.
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3. Any Connect Workflow using PlanetPress Connect plugins which connect to this
server.

Uninstallation Wizard
The uninstallation is done by running the PlanetPress Connect Setup Wizard in uninstall mode.
The Wizard consists of the following pages:
1. PlanetPress Connect Setup: An information page, listing what will be uninstalled, and
also warning about impacts upon running Applications and Services.
2. Data Management: A page that provides options for backing up or deleting Connect
data. Selections are as follows:
l

Delete Connect Workspace Data: Check this box to delete the Workspace data for
the current user, or for selected users (as determined by the "Select Users" button)
l

l

Backup Connect Workspace Data for all specified Users: Check this box
to backup the Workspace data for the specified users (as previously
determined) into a compressed ZIP file (whose location can be customized),
before deletion of the full Workspace data.

Delete MySQL objectlune Data: Check this box to delete the MySQL database
installed with PlanetPress Connect.
l

Backup MySQL Date: If the deletion checkbox is selected, this option
appears to allow backing up the MySQL database to a customizable location,
prior to uninstallation.

Note
If an error occurs during uninstallation or after/when re-installing Connect after uninstalling it,
please see: Problems during a Connect installation or version upgrade in Connect's
Knowledge Base.
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Legal Notices and
Acknowledgements
PlanetPress Connect, Copyright © 2019, Objectif Lune Incorporated. All rights reserved.
The license agreements for the associated open source third party components can be found in
the following installation folder: C:\Program Files\Objectif Lune\OL Connect\Legal Notices
This application uses the following third party components:
l

l

l

l

l

l

l

l

l

Adobe PDF Library which is either a registered trademark or trademark of Adobe
Systems Incorporated in the United States and\or other countries.
Adobe XMP Core Copyright © 1999 - 2010, Adobe Systems Incorporated. All rights
reserved.
c3p0 which is licensed under the terms of the Lesser General Public License
(LGPL) Version 2.1. The source code can be obtained from the following location:
https://github.com/swaldman/c3p0
Eclipse Gemini Blueprint which is distributed under the terms of the Apache Software
License Version 2.0. This product includes sub-components with separate copyright
notices and license terms.
Eclipse Persistence Services Project (EclipseLink), Copyright © 2007, Eclipse
Foundation, Inc. and its licensors. All rights reserved. This is distributed under the terms
of the Eclipse Public License Version 1.0 and Eclipse Distribution License Version 1.0.
Fugue Icons by Yusuke Kamiyamane which are distributed under the terms of the
Creative Commons Attribution 3.0 License.
Gecko which is distributed under the terms of the Mozilla Public License (MPL) Version
2.0. Information on obtaining Gecko can be found on the following page:
https://wiki.mozilla.org/Gecko:Getting_Started
NOTE: This library has been modified for Connect. To obtain copies of the modified
library please contact your local Objective Lune Support team.
Glassfish Java Mail which is licensed under the terms of the Common Development and
Distribution License (CDDL) Version 1.0. Information on how to download the Glassfish
source can be obtained from here:
https://wikis.oracle.com/display/GlassFish/Java+EE+7+Maven+Coordinates
Hamcrest Matchers Copyright © 2000-2006, www.hamcrest.org. All rights reserved.
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l

l

l

l

l

l

l

l

l

l

l

l

HyperSQL, Copyright © 2001-2010, The HSQL Development Group. All rights reserved.
IcoMoon. Connect uses unmodified icons from IcoMoon (https://icomoon.io/#iconsicomoon) which have been made available under the Creative Commons By 4.0 license
(https://creativecommons.org/licenses/by/4.0).
ICU4J 4.4.2 Copyright © 1995-2013 International Business Machines Corporation and
others. All rights reserved.
J2V8 which is distributed under the terms of the Eclipse Public License (EPL) Version
1.0. The source code for J2V8 can be obtained from the following location:
https://github.com/eclipsesource/j2v8
Jacob Java Com Bridge which is licensed under the terms of the GNU Lesser General
Public License (LGPL) Version 2. The source code for this can be obtained from the
following location: http://sourceforge.net/projects/jacob-project/files/jacob-project/
JavaSysMon Copyright © 2009 ThoughtWorks, Inc. All rights reserved.
JavaX Mail which is distributed under the terms of the Common Development and
Distribution License (CDDL) Version 1.1. The source code for this can be obtained from
the following location: https://java.net/projects/javamail/downloads/directory/source
Java XmlHttpRequest which is licensed under the terms of the GNU Lesser General
Public License Version (LGPL) 2.1. The source code for this can be obtained from the
following location: https://github.com/objectifluneCA/java-XmlHttpRequest
Jersey which is distributed under the terms of the Common Development and Distribution
License (CDDL) Version 1.1. Information on how to obtain the source code can be found
at the following location: http://repo1.maven.org/maven2/org/glassfish/jersey/jersey-bom
jersey-json-1.13 which is licensed under the terms of the Common Development and
Distribution License (CDDL) Version 1.1. Information on how to obtain the source code
can be found at the following location:
http://mvnrepository.com/artifact/com.sun.jersey/jersey-json/1.13-b01
Jersey Multipart which is distributed under the terms of the Common Development and
Distribution License (CDDL) Version 1.1. Information on how to obtain the source code
can be found at the following location:
http://repo1.maven.org/maven2/org/glassfish/jersey/jersey-bom
JNA Version 3.5.1 which is distributed under the terms of the GNU Lesser General
Public License Version (LGPL) 2.1. The source code for this can be obtained from the
following location: https://github.com/twall/jna/releases
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l

l

l

l

l

l

l

l

l

Logback which is distributed under the terms of the Eclipse Public License
(EPL) Version 1.0. The source code for Logback can be obtained from the following
location: https://logback.qos.ch/download.html
Mchange Commons Java which is licensed under the terms of the Lesser General
Public License (LGPL) Version 2.1. The source code can be obtained from the following
location: https://mvnrepository.com/artifact/com.mchange/mchange-commons-java
Objectweb ASM, Copyright © 2000-2011 INRIA, France Telecom. All rights reserved.
Relique CSV Driver which is licensed under the terms of the Lesser General Public
License (LGPL) Version 2.1. The source code can be obtained from the following
location: https://sourceforge.net/p/csvjdbc/code/ci/csvjdbc-1.0.31/tree/
Rhino 1.7R4 and 1.7.7.1 which are licensed under the terms of the Mozilla Public
License (MPL) Version 2.0. The source code for these can be obtained from the following
location: https://developer.mozilla.org/en-US/docs/Mozilla/Projects/Rhino/Download_
Rhino
Saxon which is distributed under the terms of the Mozilla Public License (MPL) Version
2.0. The source code for this can be obtained from the following location:
http://sourceforge.net/projects/saxon/files/Saxon-HE/9.6/
Servlet API developed by Sun as part of the Glassfish project and licensed under the
terms of the Common Development and Distribution License (CDDL) Version 1.0.
Information on how to download the Glassfish source (as part of Java EE platform) can be
obtained from here:
https://wikis.oracle.com/display/GlassFish/Java+EE+7+Maven+Coordinates
Simple Logging Facade for Java (SLF4J) Copyright © 2004-2017 QOS.ch. All rights
reserved.
Spring Framework which is distributed under the terms of the Apache Software License
Version 2.0. This product includes sub-components with separate copyright notices and
license terms.

l

StAX Utilities Copyright © 2007, StAX Utilities Project. All rights reserved.

l

Stax2 API Copyright 2010-2018 FasterXML.com.

l

Tern which is distributed under the terms of the Eclipse Public License (EPL) Version 1.0.
The source code for tern can be obtained from the following location:
https://github.com/angelozerr/tern.java
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l

l

l

l

Web Services Description Language for Java which is distributed under the terms of
the Common Public License v 1.0. The source code for this can be obtained from the
following location: http://wsdl4j.cvs.sourceforge.net/viewvc/wsdl4j/
XULRunner which is distributed under the terms of the Mozilla Public License Version
2.0. The source code for this can be obtained from the following location:
http://ftp.mozilla.org/pub/mozilla.org/xulrunner/releases/latest/source/
zziplib which is licensed under the terms of the Mozilla Public License (MPL) Version 1.1.
The source code for this can be obtained from the following location:
http://sourceforge.net/projects/zziplib/files/zziplib13/
7-Zip SFX which is licensed under the terms of the GNU Lesser General Public License
(LGPL) Version 2.1. The source code for this can be obtained from the following location:
https://github.com/chrislake/7zsfxmm

Portions of certain libraries included in this application which are distributed under the terms of
the Mozilla Public License have been modified. To obtain copies of the modified libraries
please contact your local Objective Lune Support team.
Apache Software License Components
This application also uses the following components which are distributed under the terms of
the Apache Software License Version 2.0:
l

Apache ActiveMQ

l

Apache Batik

l

Apache Commons Beanutils

l

Apache Commons CLI

l

Apache Commons Codec

l

Apache Commons Collections

l

Apache Commons DBCP

l

Apache Commons Digester

l

Apache Commons Imaging

l

Apache Commons IO

l

Apache Commons JCS Core

l

Apache Commons Lang

l

Apache Commons Logging
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l

Apache Commons Pool

l

Apache Commons Text

l

Apache Commons Validator

l

Apache Derby

l

Apache Felix and dependencies

l

Apache Geronimo

l

Apache HttpClient Mime

l

Apache POI

l

Apache ServiceMix

l

Apache Xerces2 Java Parser

l

Apache XML Graphics

l

Apache XML Beans

l

Barcode4j

l

Google Collections

l

Google GSON

l

Hibernate Validator

l

Jackson JSON processor

l

Jetty

l

Liquibase

l

LMAX Disruptor

l

Objenesis

l

OpenCSV

l

OPS4J Pax Web

l

org.json.simple

l

Quartz Scheduler

l

Snakeyaml

l

SNMP4J

l

Spring Dynamic Modules

l

UCanAccess

l

Woodstox
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Eclipse Technology:
This Software includes unmodified Eclipse redistributables, which are available at
www.eclipse.org. The Eclipse redistributables are distributed under the terms of the Eclipse
Public License - v 1.0 that can be found at https://www.eclipse.org/legal/epl-v10.html.
Java SE framework and platform:
This application uses the Java SE framework and platform which is distributed under the terms
of the Oracle Binary Code License Agreement for the Java SE Platform Products and Java FX.
Copyright 2013, Oracle America ,Inc. All rights reserved.
Use is subject to license terms. ORACLE and JAVA trademarks and all ORACLE- and JAVArelated trademarks, service marks, logos and other brand designations are trademarks or
registered trademarks of Oracle in the U.S. and other countries.
Use of the Commercial Features for any commercial or production purpose requires a separate
license from Oracle. “Commercial Features” means those features identified Table 1-1
(Commercial Features In Java SE Product Editions) of the Java SE documentation accessible
at http://www.oracle.com/technetwork/java/javase/documentation/index.html.
Further Components:
l

l

Portions of this software are copyright © 2018 The FreeType Project (www.freetype.org).
All rights reserved.
This product includes software developed by JSON.org
(http://www.json.org/java/index.html).

Click to download the EULA as PDF
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